


introduction

We all know that 2020 was a year of disruption. Everyone’s 
life was turned upside down or inside out, especially the film 
industry. Virtually all production came to a halt, except a few 
notable exceptions that we will talk about later. Completed 
films particularly blockbusters were not released as media 
companies sought to maximise their profits by waiting until 
cinemas were opened again. 
James and I got together to work on a movie in early March 
of the Covid year. We were all set to go and restrictions 
came into place. From that day on we had to work on the 
movie together and apart via Zoom. 
One of my few trips to the shops was to visit a local sheet 
retailer to buy a lime green sheet set for the green screen 
we set up in James home. A grand total of twenty five 
dollars. Next we purchased a gimbal with a small tripod 
for James iPhone so that he could shoot steady shots. We 
paid $149 for a gimbal that as of writing has dropped in 
price. I bought a Kombi van model on eBay for $20 and we 
borrowed a model train set from a friend. I edited the film 
on Premiere Pro and purchased all stock photography from 
Shutterstock. We used music and special effects from
Epidemic Sound. That was $25 for the one month we 



needed it.

This course is about film making for those with limited 
resources. It would be nice to have a huge budget but it is 
amazing what you can do with little money or equipment. It 
is also a great way to learn the film making process.

The following two Australian series made under very strict
lockdown. They demonstrate that very little resource, human 
or otherwise can lead to interesting story telling.

Cancelled

A 10 part web series shot using an iPhone, a gimbal, a small 
plug in microphone and all natural light in one location, an 
apartment in Valencia. It tells the story of the couple in the 
film who were in Spain with his mother for their wedding 
when the country went into lockdown. The couple wrote the 
series in eight days as a slightly fictionalised version of their 
lockdown experience. 

You can watch the entire series on Facebook by clicking on 
the link below:

https://www.facebook.com/cancelledtheseries/

Retrograde

This series from ABC TV is basically a scripted Zoom 
conversation between a group of friends (actors). It was 
made with each actor in their home or apartment over a four 
month period.

You can watch the entire series on ABC iview by clicking on 
the link below:

https://iview.abc.net.au/show/retrograde

This course is an outflow of much that we learned during 
lockdown. We hope it is useful in your film making journey.

James Kurtze and Timothy Wallis 

http://


motion picture that has a running time of 40 minutes or less, 
including all credits”. 
The shortest film nominated for an Academy  Award was 
“Fresh Guacomole”. It had a run time of 100 seconds and 
has over 400 million views on YouTube. 
Short films can be professional or amateur productions. 
They are often screened at local, national, or international 
film festivals. 
Short films are usually made by independent filmmakers 
with a low budget or no budget at all. Big budgets are 
rare unless created for a commercial entity such as the 
Mercedes CLA Project by vlogger Casey Neistat. 
Generally short films are funded by film grants, non-profit 
organizations, sponsors, or personal funds. These films are 
often used by independent filmmakers to prove their talent 
in order to gain funding for future films from private 
investors, entertainment companies, or film studios. 

Throughout this course when we refer to film making we are 
talking about short films not feature films, although many of 
the principles would still apply to the longer form.

What is a short film?
A short film is any film not long enough to be considered a 
feature film. No consensus exists but the Academy of Motion 
Picture Arts and Sciences define a short film as “an original 
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story

Story is probably the most important part of film making. 
When you get this right your film is more likely to 
connect with an audience. Even special effects driven 
blockbusters that are successful usually have a story that 
engages with it’s audience. When making a short, no budget 
film, story becomes even more important because those 
things available to big budget projects such as name actors, 
high level production values, exotic locations and a massive 
special effects team are generally unavailable to the no 
budget or micro budget film maker.
Although broadcast TV is on the wane and most viwers 
world wide now consume their programming via streaming 
services the theory behind the story telling is really very 
ancient.
For instance the three act structure built around a 
beginning, middle and end is thought to have originated with 
the Greek philosopher Aristotle who lived in the third century 
BC. This stucture is still at the heart of most storytelling 
today.
More recently the “Hero’s Journey”, used most famously by 
George Lucas when he wrote Star Wars, was articulated by 
Joseph Campbell in his book on the structure of hero myth 



narratives, “The Hero With A Thousand Faces” originally 
published in 1949. 
Campbell was an American professor of literature at Sarah 
Lawrence College who worked in comparative mythology 
and religion. His work covers many aspects of the human 
experience.
It was adapted for screenwriting by Christopher Vogler in his 
book, “The Writer’s Journey: Mythic Structure For Writers” in 
2007.
More recently beat sheets have become an important tool in 
structuring the plot of film and television stories. 
A beat sheet identifies the important moments in a series or 
feature film, and lays out what needs to happen in each act 
of the story.
One of the most widely known and used beat sheets was 
created by screenwriter and author, Blake Snyder. He
wrote “Save the Cat”, one of the most widely read books 
on screeplay structure.
Many screenwriters and the films created from their screen 
plays now overlay the three act structure championed by 
Aristotle with the character arc of the hero’s journey and 
the more detailed plot mapping of a beat sheet. While the 
filmmaking industry, particularly Hollywood, can be accused 
of following such formulas too slavishly, they are a a great 
place to start if you are going to write a feature film or 
episodic television. These three approaches used together 
plotted on the following page. 

You can download a copy of the document at the link below:

https://static1.squarespace.com/
static/5f36585c99bf563f56a3f220/t/61389abf082936118492
39e6/1631099584377/Three+story+structures.pdf
 
Although it is helpful to keep these structures in mind, when 
writing short films the approach needs to be slightly 
different. It would be impossible to touch every point outlined 
above in a short film.
There is no one way to create a short film but the following 
steps are designed to help you get started. 

https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/61389abf08293611849239e6/1631099584377/Three+story+structures.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/61389abf08293611849239e6/1631099584377/Three+story+structures.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/61389abf08293611849239e6/1631099584377/Three+story+structures.pdf


Step 1: Find a small idea

Every short film needs, at its core, an “idea.” This idea can 
be as simple as a sentence, an image, a metaphor, or even 
a line of poetry. Whatever device you use to express the 
idea it must be able to be explored in some depth in a short 
period of time.
Think of your film as the visual expression of this small idea. 
The following examples can all be found on the Sit Down 
Shut Up and Watch website. To find the films, click on the 
links below each picture.

Phone Home
James and his lost phone embark on a magical journey to 
be reunited.

https://www.youtube.com/watch?v=CXghh-LIIt4

Second Date
When a date goes wrong, a boy uses his wheelchair to go 
back in time to fix it.

https://www.youtube.com/watch?v=7SdYapBKjC4

Optometrist
A simple eye test becomes a struggle for life and death.

https://www.youtube.com/watch?v=r9zk2-XpwTA

What unites these films is that they are built around short 
and simple ideas.
The most common mistake new filmmakers make is that 
they try to tackle too much. If the film description is longer 



than one or two sentences, the idea is probably too large. 
You will end up skimming over a complicated story. Short 
films are a great way to explore a single, clear event in the 
life of one character. They are a poor way to explore 
multiple, complex events in the lives of many characters.
So find a small idea which excites you and can be described 
in a single sentence.

Step 2: Write a treatment

Next you will put together a treatment document.
A treatment is a story document that is often completed 
before the script or screenplay is started.
Don’t focus on dialogue before you have completed this 
step! (Although you should note down snippets of dialogue 
that come to mind for later use or inspiration.)
It is all written in third person, present tense. 

What is third person, future tense?
Third person means the subject is either he, she, or it (for 
singular) or they (for plural).
Present tense means a simple verb tense indicating the 
present.
Examples:
He snores loudly.
She speaks slowly.
It eats noisily.
They run fast.

This treatment document can help you think through the 
elements of your story before you start your script and set 
up the world you want the communicate
It is like a road map that will aid you on your filmmaking 

journey. It will help you identify plot holes, or parts of the 
film that need to be developed. It can assist you in the 
development of characters and work out they relate to the 
story.
It comes in many forms but your treatment will include the 
following: the title, a logline, a story summary, character 
descriptions, the structure and an epilogue.

a. Title
Give your treatment a title, even if it’s just a working title.
A title should be something that captures the essence of 
your story. Some titles use the names of a character (I am 
Felix), 

https://www.youtube.com/watch?v=GcEH4IvsYmQ



or the premise, (Two Deaf Travellers). 

https://www.youtube.com/watch?v=nLzzNg4l6BA

Titles should be as original and memorable as possible, and 
not sound like an existing film title.

b. Logline
A logline is a brief sentence (or two) that captures the main 
idea of your movie. You may find that your “find a small idea” 
sentence completed in step one will act as a basis for the 

the setting, (Meteor Bunker), 

https://www.youtube.com/watch?v=tYZVPtbVXIY

logline. You should include following in your logline:

Identify the protagonist. 
Describe the inciting incident. 
Highlight your protagonist’s goal.
Create a gripping central conflict.

While no two film log lines are the same, you can use this 
template to get you started:
When (INCITING INCIDENT) happens, 
(OUR PROTAGONIST) decides (TO DO ACTION) against 
(ANTAGONIST).

What is an Inciting incident?
An event in a story that upsets the status quo and begins a 
story’s movement.

Who is a protagonist?
Protagonist comes from a Greek word for the principal actor 
in a drama. In modern storytelling, the protagonist drives the 
story forward by pursuing a goal. The protagonist of a story 
is sometimes called the main character. The protagonist of a 
story is opposed by an antagonist. The protagonist might not 
be a nice person but they are the character through whose 
eyes we see the story.

Who is an antagontist?
The antagonist is the principal source of conflict for the 
protagonist. Often, the antagonist is a villain, but he doesn’t 
necessarily have to be. He may just be someone who 
has a different agenda from the protagonist. Antagonists 
might be one person, a group, or even an animal or other 
natural phenomena. Most distaster movies fall into the latter 
category although many often have a human antagonist 



who adds to the torment of the protagonist.

Here is an example from the film, Clown Crime:

When their scooters are stolen, the dancing Pirate Crew 
pursue the Clown Gang and the Zombies to get them back.

https://www.youtube.com/watch?v=1u6jXt3G5Z0

c. Summarize the concept
This is a synopsis of your idea and should read like a short 
story. 

What is a film synopsis?
A film synopsis is a brief summary of a story’s core concept, 
major plot points, and main character arcs.

Write it in the third person, present tense like the rest of your 
treatment document. It should present the entire story in-
cluding the ending. Do not write this in screenplay form un-
less you feel it is necessary to present key scenes and dia-
logue. Such documents are now called scriptments!
During this stage you will expand on the shorter log line, and 
begin to understand how the film will play out. This is also 
where you can establish the theme, tone and surface any 

relevant background that is essential to your story concept.
 
d. The main characters
Define your character, their problem, world and a solution.
Successful short films usually consist of a Character with a 
Problem in a World we understand looking for a Solution.
These elements are the building blocks that will help you 
structure your film and find an emotionally satisfying 
solution.
Ask yourself the following questions: 
Who is my character?
Why and where are they experiencing their problem? 
What is the solution?
How will they develop? Write down their possible arcs.

What is a character arc?
A character arc describes the transformation of a character 
over the course of a story. The character begins as one sort 
of person and gradually transforms into a different type of 
person in response to what happens to them, for example, 
they move from greedy to generous because of the 
difficulties they themselves experience. Character arcs are 
generally reserved for the chief protagonist although other 
characters can change as well.

Who else is going to be in this story? What do these 
characters want? Their goals may be very different to the 
main character and this can set up a conflict that brings 
excitement to your film.



e. Explore the structure of your idea
You might think of a short film as having:
i A beginning
ii A middle
iii An end
Ask yourself how the beginning relates to the end, the 
middle to the beginning, and the middle to the end.
Once you’ve set up the world and its inhabitants, it’s time to 
delve into the story itself. How does the story begin? What 
do we open on? Who do we see? Tell the tale of your film as 
if it were a short-story, and include all the interesting 
moments to keep the reader engaged in the world you’ve 
created. The length of your story summary depends on you 
as a writer. Some writers create short one-page summaries, 
while others use 70 pages to tell their film’s story. (The latter 
for feature films.) Do what is necessary to help you 
understand the story.

f. Epilogue. 
The final paragraph of your treatment wraps up the 
narrative. Describe the ending. How does the premise 
conclude, what happens to all the characters, and what do 
they learn, if anything. Give the reader a sense of what will 
now happen in this world.

STEP 3: Create a beat sheet

What is a beat sheet?
A beat sheet identifies the important moments in a film or 
the episode of a series, and lays out what needs to happen 
in each part of the story. 

We mentioned earlier that the “Save the Cat” beat sheet is 

used by many screenwriters to structure their films. While 
some lament this formulaic approach it can be a very 
helpful way to make sure your film holds together. Feature 
films generally have a fairly detailed beat sheet but your 
short film will have less beats. 
At this point of the process you should be thinking about 
visuals with a strong image for each beat. Show, don’t tell.

You could beat out your short film using the following 
template: 

Beat 1. Introduce the world of your character
Beat 2. Introduce the character
Beat 3. Introduce the character’s problem
Beat 4. How does the character solve the problem
Beat 5. The character experiences a set back 
Beat 6. The character discovers the solution

https://www.youtube.com/watch?v=rG3AdIKecEU

Dania’s Checkerboard is an example.



In this film the group is the protagonist.

Beat 1. A day care centre for those with a disability.
Beat 2. The group play board games at the day care centre.
Beat 3. None of them can beat Dania at checkers.
Beat 4. Member after member plays Dania.
Beat 5. All of them lose.
Beat 6. Tim, the last player pretends to cry as he starts a 
game against Dania. While Dania gets up to comfort him, 
another member of the group removes a number of Dania’s 
pieces. When Tim and Dania sit back down he beats her.

STEP 4: Understand the script format

All scripts worldwide are formatted in the same way, so it 
is helpful to use scriptwriting software that automatically 
formats your work. Even if you are writing a short film you 
should learn to use such a program. Each page of script 
when formatted correctly usually equates to about a minute 
of film.

Final Draft is the daddy of all screenwriting software. It is 
worth the purchase if you can afford it and will use it a lot.
You can buy it at the Final Draft website as a digital 
download:

https://store.finaldraft.com/all-final-draft-products.html

There are free cloud based versions from which you can 
download your script as a PDF. Studio Binder has online 
software that you can use for free but you can only write one 
film per account. 

You can access the Studio Binder screen writing software 
at:

https://app.studiobinder.com/register?screenwriting

a. Title Page
The first page of your screenplay is Title Page. This page 
shows the title of the screenplay and who the screenplay 
is written by in the center of the page. The writer’s contact 
details appear at the bottom of the page in the lower left 
hand corner.

https://store.finaldraft.com/all-final-draft-products.html
https://app.studiobinder.com/register?screenwriting


b. Page Margins
Here are some guidelines regarding page margins for your 
screenplay. Remember – screen writing software 
automatically formats your margins for you, so you don’t 
have to worry about doing it yourself if you are using such a 
program. But if you’re interested in what the guidelines are, 
this information will be helpful. The top margin needs to be 
25mm. The bottom margin, and your right margins should be 
30mm. The left, or inside margin needs to be approximately 
40mm to allow space for the three-hole punch binding 
needed when your screenplay is printed.  

c. Font and Page Numbers
You must use 12 point Courier font. This font is the 
entertainment industry standard. The top of the page, or 
header, should only contain the page number, flush right, 
about 12mm from the top of the page, and followed by a   
period. The first page shouldn’t have a page number.

c. Scene Headings
A screenplay is comprised of a number of different scenes, 
and every scene starts with a scene heading, also known as 
a slug line.
A scene heading consists of three elements:
Where the scene takes place i.e. inside (INT., short for 
INTERIOR) or outside (EXT., short for EXTERIOR);
The location where the scene takes place (a house, a bus, 
the outback etc.);
The time of day (DAY, NIGHT, MORNING, AFTERNOON, 
EVENING, ETC.)

Here are two examples of scene headings from the Phone 
Home film script with a still from each scene at (2:09) and 
(4:55)
INT. JAMES’ BEDROOM, KURTZE HOUSE – MORNING

Be very specific with your scene headings, so the reader 
knows exactly where they are. 
When writing a scene set inside, you can be very exact 
about what room the scene is taking place in by adding 
a further descriptor to the scene heading followed by a 
comma. 
This scene heading tells us that we are in a James’ bedroom 
in in the Kurtze home and it is morning. 
EXT. THE SKY, ADELAIDE – NIGHT



This scene heading tells us that the scene is taking place 
outside, that we are in the sky over Adelaide, and that the 
scene takes place at night.

d. Action and Dialogue
A scene in a screenplay is composed of action and dialogue. 
The action tells you what is happening in the scene and 
dialogue indicates what each character is saying. After you 
write your scene heading, you should write a few lines of 
action to get the reader situated in your story. (The 
following examples are all from Phone Home unless 
specified.) The following example is at (0:15):

aflg
INT. THE HEAT BEAT CLUB – NIGHT
The nightclub throbs with music. The packed crowd bounces to the 
beat. DJ JAMES KURTZE wears a satisfied smile as he works the 
controller. Life is sweet.

Dialogue is indented and centred on the page. Once 
again Final Draft and other screen writing software will 
automatically set the correct indents for you. 
The name of the character speaking precedes a block of 
dialogue.  This is called a CHARACTER CUE.  This cue is 
always in capitals. Here is an example at (1:22):

aflg
JAMES

                 I lost my phone.

Sometimes the dialogue for a particular character might 
continue over a page break. Screen writing software 
automatically handles this in the following way.
On the bottom of a page where a block of dialogue begins 
you will see the word MORE in upper case letters, 
parentheses, and centered. This tells the reader there’s 
more dialogue to come on the following page from the same 
character. Dialogue will be broken at the end of a sentence 
for a page break. At the top of the following page, the 
character cue is followed with a CONT’D to let the reader 
know that the dialogue begins on the previous page. 

There is a third dialogue element that you should use 
sparingly. It’s called PARENTHETICAL direction, because 
it is inside parenthetical marks underneath the character 
cue. It tells the actor how the dialogue should be delivered. 
Parenthetical direction is used when the script doesn’t 
convey how the actor might deliver the dialogue. For 
example:
       JAMES
           (loudly)
                 I lost my phone.



A parenthetical can be used to describe who is being 
spoken to. Here is an example at (1:07):

aflg
James

                      (to self)
                  Hmm! Hmm! Hmm!

A parenthetical can also be used beside the character cue 
in very specific circumstances. If your character is speaking 
OFF SCREEN (O.S.). Here is an example in Parent’s Inc. 
(0:38

https://www.youtube.com/watch?v=QMGWDiqWRDA

Girl
(O.S.)

I got to tell them.

A narration or VOICE OVER (V.O.). See The Fish Don’t 
Care When it Rains as an example (0:25)

EXT. RIVER BED – DAY
A child, Jenny Msumba stands awkwardly in front of someone with an 
old home video camera.

Jenny (V.O.)
Hi. I’m Jenny Msumba. If you search the internet you’ll find I’m 
the only one in the world with that name.

e. Transitions
You don’t need to include any written transition between 
scenes, as it’s understood that one scene naturally flows 
into the next.
So now we’ve gone through the elements that make up a 
script: a scene heading, action, and dialogue. Remember 
that if you use screen writing all formatting will be correct. 

Step 5: Write The First Draft

Writing for film is about telling stories in pictures in the most 
economical way possible. 

https://www.youtube.com/watch?v=Sad5AtBikFI



When writing the first draft don’t judge your writing, just let 
it flow. Writing is really re-writing, so write your first draft as 
fast as you can, and don’t read it back until you are finished.
We will use the film The Hobbyist as an example.

Act 1. The Set-up
In its simplest form the set up should ask the the following 
questions.
Who is protagonist? Who is the antagonist? Where are we? 
What’s happening?
A quick launch into the story helps the audience stay with 
the film.
Remember we mentioned earlier that a protagonist is 
not necessarily the hero but the character through whom 
the story is viewed. The antagonist is the character who 
thwarts the goals of the protagonist. In The Hobbyist the 
protagonist is a villain and the antagonist is more of a hero. 
In this film we meet the married protagonist carrying a small 
suitcase. The antagonist is an elderly perfumer who plies his 
trade in his basement workshop. 
The dimly lit basement is lined with floor to ceiling shelves. 

Act 2. The protagonist enters a point of no return
A point of no return is the moment we watch the character 
make a few choices which ultimately take them so deep into 

https://www.youtube.com/watch?v=p1TYNDS0o20

the drama that there is simply no going back. They must 
deal with the problem or face great difficulties.
Raise the stakes.

What does raising the stakes mean?
Conflict. The greater the conflict and the more characters 
have to lose as a result of that conflict, the more the stakes 
are raised. When the stakes are raised, audiences will be 
more invested in your story.

In The Hobbyist the protagonist seeks an undetectable 
poison to murder his wife. The perfumer offers the 
protagonist a drink of coffee and refuses his request.
The protagonist pulls a gun. The perfumer divulges that 
he has placed undetectable poison in his drink. When he 
demands the antidote the perfumer lays out the cost.

Act 3. Resolution or tie-up.
End your film. It sounds easy but coming to a resolution can 
be tough. Does the antagonist have the last say? Does the 
protagonist get away? Or do you write an ambiguous 
ending?
Either way your audience wants to feel changed by watching 
your work. 
A great way to resolve end of your film would be to have 
three people you know, read your script. Get them to read 
it all the way to the end of act two and ask them how they 
want it to end. Reflect on the information for a few days and 
then return to the keyboard and finish the third act.
In The Hobbyist, the perfumer says that if the the 
protagonist murders him or his wife, a policeman whom 
he called while making the hot drink, will begin a criminal 
investigation.



Step 6: Find a constructive and knowledgable critic

Your critic is someone you know, or can contact, who 
understands scripts.       
This is NOT usually someone who wants to please you, 
such a family member or close friend but doesn’t know how 
to read a script. They will often tell you they loved it or hated 
it but have little useful feedback to improve it.
Your critic, on the other hand, will read your script and give 
you an honest appraisal. Listen to their feedback, and then 
do a considered rewrite, taking your time, based on their 
comments. Do not be defensive. Listen to what your critic 
says and act.
There are script reading services but you have to pay for 
those. If you have the money and are serious about your 
film making they can be a useful resource.

Step 7: The second draft

As you start your second draft and read it over again you 
will probably see a lot of problems with it. This is a perfectly 
normal experience. Refer to the notes from your critic.
Try to make this draft the one which clarifies everything, 
that focuses in on the problems and irons out any 
inconsistencies. Be prepared to throw away your favourite 
scenes. If they don’t advance the story, get rid of them.
Remind yourself of the image, idea or metaphor that started 
your story journey. Remember how excited you were with 
that idea, but based on feedback, try to tell the story in a 
different way.

Step 8: The third draft

Rewrite the script again.

Step 9: The storyboard

Steven Spielberg quote:
The storyboard for me is the way to visualise the entire 
movie in advance.

The last two steps of story involve the look of the film. We 
have been dealing with words but now is the time to turn 
to pictures. It is time to work out how the film will look shot 
to shot. We will do this using a storyboard. It is will indicate 
where the actors will be positioned, what type of shot will be 
used i.e. close up, wide shot etc., what props will be needed 
and sometimes the even the location of a scene. They will 
help you when you are on set to construct the scene without 
too much delay.
One of the common complaints when approaching the 
creation of a storyboard is, “But I can’t draw.” 
While you can create more detailed storyboards like the one 
for Jame’s next movie, “Lockdown”, stick figures are enough 
as long as they remind you what the shot will look like.



https://static1.squarespace.com/
static/5f36585c99bf563f56a3f220/t/61386d87c5ffe815c8140
24d/1631088011877/Lockdown+storyboard.jpg

Storyboard 16:9 Production: Date: Page:

Scene: Shot: Scene: Shot: Scene: Shot:

Scene: Shot: Scene: Shot: Scene: Shot:

Type: Type: Type:

Type: Type: Type:

https://static1.squarespace.com/
static/5f36585c99bf563f56a3f220/t/6125fa5c1e42137452
9f9985/1629878876411/Horizontal+storyboard.pdf

16:9 Production: Date: Page:

Scene: Shot:

Scene: Shot:

Scene: Shot:

Scene: Shot:

Type:

Type:

Type:

Type:

https://static1.squarespace.com/
static/5f36585c99bf563f56a3f220/t/60ee8ffffb3cc800db59e
ae0/1629879842273/Vertical+storyboard.pdf

What should you include on your story board?

a. Production name
The working title of your film.

b. Date
When you drew the storyboard page. This enables you to 
keep track of different versions of your vision for the film.

https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/61386d87c5ffe815c814024d/1631088011877/Lockdown+storyboard.jpg
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/61386d87c5ffe815c814024d/1631088011877/Lockdown+storyboard.jpg
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/61386d87c5ffe815c814024d/1631088011877/Lockdown+storyboard.jpg
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/6125fa5c1e421374529f9985/1629878876411/Horizontal+storyboard.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/6125fa5c1e421374529f9985/1629878876411/Horizontal+storyboard.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/6125fa5c1e421374529f9985/1629878876411/Horizontal+storyboard.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/60ee8ffffb3cc800db59eae0/1629879842273/Vertical+storyboard.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/60ee8ffffb3cc800db59eae0/1629879842273/Vertical+storyboard.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/60ee8ffffb3cc800db59eae0/1629879842273/Vertical+storyboard.pdf


c. Page
To keep them organised you may like to put them in a ring 
binder with the story board on the left and the shot list on 
the facing page.

d. Scene
A scene is where a series of events happen in the same 
place.

e. Shot
Your scene is comprised of a number of camera shots. You 
should number these.

f. Type
The basic camera shots are a close up, a medium shot, a 
long shot, an extreme close up or an extreme long shot?

g. Description
What is happening in the shot? What are the actors doing? 
Include anything in a sumary form that will be helpful for you 
when you come to shoot the film.
On the following page storyboard frames for “Phone Home” 
have been placed alongside frames from the finished film to 
demonstrate what storyboards are meant to do.
The drawings are simple line drawings and the instructions 
are minimal but enough to know what has to done in each 
shot.

It is helpful when drawing your storyboard to understand the 
three ‘basic’ fixed camera shots in any film. They are the 
Close up, Mid shot and Wide shot. These shots are 
illustrated with images from the My Daughter Yoshiko 
supermarket scene.

Close up

Mid shot

Wide shot



STEP 10: The shot list

A shot list is a document that maps out everything that will 
happen in a scene by describing each shot within your film. 
It serves as a checklist, providing the project with a sense of 
direction and helps the film crew to prepare.

It is put together by the director, cinematographer, and 
sometimes the first assistant director. Shot lists are 
especially critical in managing and preparing for film scenes. 
Making a movie demands knowledge of shot type, camera 
movement, lighting, actor staging, and much more. Putting 
this information down in a shot list helps you as a film 
makerremember what you want and how to execute it.

It will also help you determine equipment needs, how long 
shot setups will take and so many other aspects of the 
schedule and budget. 

What should you include on a shot list?

A brief description of shot: action and characters
Scene number and shot number
Location (Interior or exterior)
Shot type (close-up, wide shot, mid shot etc.)
Camera angle
Camera movement
Setup time
Subject
Description

The Excel spread sheet is over the page. You can download 
it there from the link under the image.



My film name here
Scene number Shot number Interior/exterior Shot Camera angle Camera movement Set up time Subject  Description

1

https://www.sitdownshutupandwatch.com/story-resources

STEP 11: File management

1. Organise Your Hard Drive
Keeping your assets organized is vital. 
When you are in the excitement of creativity, the temptation 
is to make and make and make. When you come to look 
at what you have created or to start to edit it is vital that 
you can find everything easily. It will save you are lot of 
frustration in the long run.
Here’s one way you can do it.

Audio
There are 4 folders inside the Audio folder:
i. Recordings
This folder is used for recordings that you record alongside 
your camera audio. The quality of this audio should be 
of a higher quality but we will look at how to create these 
recordings in the sound section. (They can be wav or mp3 
files.)

ii. Music (stock music or original music)

iii. SFX (stock sound effects or original sound effect)

iv. VO (voice over)

Documents
This folder is used for scripts, interview questions, project 
briefs, casting notes, etc.

Drafts
This folder is for intermediate versions that you and your 
team can look at. (They can be mp4 files.)

https://www.sitdownshutupandwatch.com/story-resources


Graphic Effects (GFX)
This folder is used for any non-footage elements like logos, 
images, pre-rendered lower thirds, motion graphics, etc.

Projects
This folder is used for all project files, including Premiere, 
iMovie etc.

Visual Efects (VFX)
This folder is distinct from the GFX folder and is used for 
any footage shot for green screens etc.

Video
This folder is used for your original footage.
Create sub folders for each scene and possibly each day if 
you shoot across multiple days.

2. Save your files in multiple locations
Equipment can fail and it is vital to save these files in at 
least two locations. Save one on a computer and one on a 
hard drive.





equipment

1. Camera

A smart phone with a 4K video camera comes as standard 
with most smart phones these days.



2. Gimbal

A gimbal is a handheld mechanical stabilizer that can help 
you shoot smooth, cinematic footage without the need for a 
larger tripod or an expensive dolly.

DJI Osmo Mobile 3
With a 3-axis gimbal that effectively reduces shaky footage, 
Osmo Mobile 3 delivers a super-smooth, stabilized image. A 
lightweight, ultra-responsive design reacts to your 
movements in real time, letting you focus more on the 
moment at hand.

The DJI OSmo 3 is not compatible with all smart phones. 
You can access their phone compability list here:

https://static1.squarespace.com/
static/5f36585c99bf563f56a3f220/t/6137f4bad7c08d36976
599ed/1631057082795/Osmo_Mobile_3_Mobile_Phone_
Compatibility_List_en.pdf

3. Microphone

When considering microphones remember that the closer a 
microphone is to the talent the better the audio quality.

a. Camera microphone
Most smart phones have an inbuilt mocrophone. Usually the 
audio from the camera is not of the highest quality but it is 
absolutely necessary so that you can synchronise with other 
sources of audio.

b. Lapel microphone
Lapel microphones also known as lavalier microphones are 
very good for recording voices.
Rode microphones, built by an Australian company, are one 
of the most respected in the film and television industry.

i. The Rode SmartLav
This microphone can be used with an old smart phone as 
the recording device. This microphone can be purchased 
from a specialist music store for as little as $89. 

https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/6137f4bad7c08d36976599ed/1631057082795/Osmo_Mobile_3_Mobile_Phone_Compatibility_List_en.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/6137f4bad7c08d36976599ed/1631057082795/Osmo_Mobile_3_Mobile_Phone_Compatibility_List_en.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/6137f4bad7c08d36976599ed/1631057082795/Osmo_Mobile_3_Mobile_Phone_Compatibility_List_en.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/6137f4bad7c08d36976599ed/1631057082795/Osmo_Mobile_3_Mobile_Phone_Compatibility_List_en.pdf


4. Green screen

Green screen allows you to drop in whatever background 
image you want behind actors and/or objects. This method 
is used in film and television production including news and 
weather.
Actors or objects must be filmed in front of a green screen.
The background images are then added during the editing 
process. This will be explained later on.
To create these alternative backgrounds using green screen 
you will need to purchase a lime green sheet set.
You can also use pale or sky blue sheets if your actor is 
wearing green or if you are filming a green object.
You can buy a frame to hang your sheet but the alternative, 
taping it to a wall with electrician’s tape, is much cheaper.

5. Lighting

Obviously the cheapest form of lighting is natural lighting.
Fit for purpose LED lights are relatively cheap and a 
available from online stores but here are some even 
cheaper alternatives:

a. Reflectors
These discs of reflective material bounce existing light onto 
your subject. If you don’t want to purchase one of these you 
can use large sheets of white cardboard.
aflg



b. Paper lanterns
Nearly every lighting store or home furnishing store will 
sell these lanterns for as little at $7. Amazon sells 20 for 
under $30. They emit a beautiful soft light that can be used 
as a key, fill, or even a background light and are extremely 
adaptable. 
For daytime use, you can switch to daylight balanced bulbs, 
which makes them such a versatile and valuable tool.
They can be mounted on a light stand, used on a boom pole 
(for walking scenes), or rigged up just about anywhere. 

c. Work Lights
These common construction lights can be bought at just 
about any hardware store for about $30, and considering 
the amount of power they can generate, they tremendous 
value. You can buy these lights with tungsten or daylight 
balanced bulbs which makes them extremely versatile, 
and their strong output makes them a great option for 
demanding lighting situations such as night exteriors. These 
lights have been used in countless feature films (even large-
scale productions such as Fight Club), and are a must have 
for a Director of Photography on a budget.



d. Energizer LED Folding Area Lantern
These little light panels are available at most hardware 
stores. They are often used for camping or as a means to 
light up a completely dark area at night. As such, they well-
suited for use on a film set. The light quality and fall off from 
these little panels can be very similar to small LED lights. 
Use these lights as a soft key or fill light, as they do a great 
job of illuminating skin tones in a natural way.

e. Clamp Flood Lights
These lights have been used for many years by filmmakers 
and photographers on a budget. They can be bought for as 
little as $23 from your local hardware store. 
They offer a great solution as an inexpensive, high power 
output. You can use a single lamp as a high key (or add 
diffusion to it if you prefer) or combine multiple lamps to 
illuminate an entire room.





team

1. Crew

a. Director 
The director is responsible for all the creative aspects of a 
movie. They usually helps hire actors, decide on locations 
and plan the shots before filming begins. During filming the 
director oversees the actors and crew, sets up shots and 
keeps the movie on schedule and on budget with the help 
of an assistant director. They also oversee the entire post 
production process especially editing.

b. Cinematographer 
The cinematographer, or director of photography (D.P.), help 
create the look of a movie. The D.P. directs the lighting for 
each scene, helps frame shots, chooses lenses and ensures 
that the visual look of the film conforms to the director’s 
vision. The cinematographer usually does not operate the 
camera on set (this is the role of the camera operator).



c. Camera Operator 
The camera operator is a member of the camera crew and 
runs the camera as instructed by the director and the 
cinematographer. The camera operator is responsible for 
keeping the action in frame, and responding quickly to the 
action as it unfolds.

d. Gaffer 
The gaffer is the chief electrician on the set and is 
responsible for lighting the set according to the instructions 
of the cinematographer.

e. Sound recordist
Sound recordists capture all of the sound on the set or 
location. This can include dialogue, singing and action. 
They set up microphones and deal with any issues around 
their placement. They think about the combination of 
microphones needed, such as a boom microphone and 
hidden microphones on the actors. 

f. Boom Operator
The boom operator is a sound crew member who 
handles the microphone boom, a long pole that holds the 
microphone near the action just out of frame, allowing the 
microphone to follow the actors as they move.

When you are making a short film with little or no budget 
you may find yourself in most or all of these roles.

2. Actors

Martin Scorcese one of the great American directors said, 
‘Directing is 90% Casting’. You may have the perfect script, 
great cameras and stunning set design but none of that 
will matter if the acting is poor. On a professional film set a 
casting director is hired to focus on this crucial task.
As a small filmmaker with a lot to do you may find that 
casting is not given the attention it needs. When you are 
planning to make your film be sure to set aside time for 
casting.

a. Where To Find Actors
If you are working on a small film you will have to simplify 
the casting process. Do you know someone who could act in 
your film. Your early film projects do not have to be perfect, 
so start off by casting friends and family members.
Professional filmmakers generally find actors through a 
talent agency. If you have some budget find a local agency 
and email them with details of the production. If you don’t 
have a budget a professional actor might work on your film 
if the screenplay or subject matter interests them. Actors 
might also choose to work on low budget films for extra 
showreel material.
Actors like all freelancers will have their own daily rate.
If your project is low or no budget and you can’t afford to 
pay your actors you could cover travel expenses during 
production.

b. How To Cast Actors
Casting actors for your small film need not be difficult. The 
right actors will enhance your story and emotionally engage 
with the audience. With some pre-planning you can find 
talented actors who are committed to your project.



i. Find a space to hold your audition
If you are currently a student you could use a spare room 
at your school or university. Pubs, cafes and libraries often 
have function rooms that you can book for free or for a 
small price. Ideally, you should have a waiting room and a 
separate room for the auditions.

ii. Book time slots for each actor’s audition
When organising an audition day determine how much time 
you will need with each actor and book specific times for 
each person.

iii. Choose a specific scene for the audition
For the audition, actors will read a few pages from a scene. 
If there is little dialogue then you can provide a scene from 
another film. Actors should be given a copy of the script prior 
to audition day and if possible a breakdown of the story and 
characters.
If your film is a musical then you will have to ask the actors 
to prepare a song to perform. 

iv. Introduce yourself to every actor
When an actor arrives have a short conversation about the 
project, the actor’s past experience and their availability for 
work. If you are the director it is important that you get along 
well with any actors you choose. When the actor is reading 
from the script, you may need someone else to read out 
dialogue for them.

v. Capture every audition on camera
Film each audition. People look different on camera than in 
real life and you will be able to look back at the audition clips 
to help with the final decision. Take photographs of each 
actor and make a few notes on each performance when the 

audition is over.

vi. Thank every actor for their time
After the audition, thank every actor for attending and let 
them know when they can expect to hear back from you. 
When you have determined who you want to cast, contact 
every actor and let them know the results. You might also 
need to do a second or third audition to see how two 
actors work on camera alongside each other. It’s also good 
practice to keep hold of everyone’s details in case your first 
choice actor is suddenly unavailable.

3. Directing Actors

i. Rehearse in detail
Allow two sessions. Schedule a full day for a 10 page script.   
Use the rehearsal to improve the dialogue and shape the 
actor’s performance.  You and the actors should collaborate 
and agree on the performance during this rehearsal period. 

ii.  On set, scrutinise your actors performance
Look for anything you would like to change in terms of the 
performance. 

iii. Keep any feedback clear and short
Don’t confuse the actor with too many instructions on set. 
They may lose confidence in themselves or you.

vi. Get your actors to tone it down 
Talking quietly, thinking loudly is so important in screen 
acting.  It is the opposite to the theatre. Many actors who 
are new to the filmmaking process will not know this. There 
will be times when an actors needs to be loud, i.e. during an 



argument or a fight sequence. Watch for overacting and pull 
the performance back where necessary.

v.  Actor Continuity
The other big challenge for new actors is continuity of 
performance. If they pick up a pen with the left hand in the 
wide shot, they must do the same in the close up. This can 
negatively impact the editing process if not attended to. 
Keeping continuity in mind is part of an actor’s job. You also 
need to be across continuity issues. On large films there is a 
crew member who watches for continuity lapses.

vi.  Watch for the blinkers in your close ups 
Great actors portray their screen performance via their 
eyes. It is no accident that the big stars always control their 
blinking and do not do it. 

vii. Ask your actor to give it their all emotionally in the 
close ups. 
Close ups are vital for the final edit. 

viii. Watch all your actor’s footage and note their best 
moments on each take. 
Taking time to do this will improve actor performance and 
make sure you have the necessary coverage. It will also 
make you editing process easier.





cinematography

What is cinematography?
Cinematography is the art and craft of making motion 
pictures by capturing a story visually. Taken from the Greek 
for "writing with movement," cinematography is the creation 
of images you see on screen. A series of such images form 
a cohesive narrative. Cinematography composes each 
image based on the storytelling needs of each scene. In 
narrative filmmaking it is not just art for art’s sake.

Cinematography is made up of the following elements, 
though these are not exhaustive.

1. Composition
2. Shot size
3. Camera placement
4. Camera movement
5. Colour
6. Lighting



What is film composition?
It is the way a scene is arranged within the camera frame 
to convey a certain message. Through the elements of 
composition, deeper meaning can be conveyed without 
needing to tell the audience exactly what’s going on.
Film composition is a vital element in the creation of a movie 
as it can draw the eye of the audience to a certain person or 
object while creating beautiful imagery. The five basic rules 
of composition are:

1.Rule of thirds
2. Balance and symetry
3. Leading lines
4. Headroom
5. 180% rule

Under each explanation is an example from a film shown in 
the SDSW Film and New Media Festival.

1. Rule of thirds
Divide your frame with three horizontal and three vertical 
lines. Place the part of subject you want your audience to 
focus on at one of the four intersecting points sometimes 
known as ‘crash points’. 
Gridlines are built into your DJI Mimo app. They can help 
you compose your shots as they are a constant reminder 
of the rule of thirds. They can be turned on by following the 
instructions on the coming page.

Navigate to your DJI app home screen. 
Click on the three dots in the bottom left hand corner.

Click on the icon at the top that looks like a piece of film. 
Click on the ‘Grid’ tab and ‘Gridlines’ in the drop down menu. 

Gridlines will now appear on your home screen every time 
you shoot video. 

1. Composition



‘unHeard Of’

https://www.youtube.com/watch?v=xtdaQpE5k-
CY&list=PL3PLBv5OrbIpxFFDcwMRMKFcbAFA1bX-
Vx&index=4&t=12s

2. Balance and symmetry 
Balancing the left and right sides of the frame normally 
gives a feeling of harmony and an unbalanced frame one 
of tension. While counter to the rule of thirds, sometimes 
completely symmetrical framing with the object of interest in 
the centre can be extremely effective.

‘Whichiswhich’

Balance doesn’t have to be symmetrical, though. Objects on 
one side of the screen can be balanced with objects on the 
other side of the screen that aren’t their mirror image.

https://www.youtube.com/watch?v=I1uHvlkLzT-
g&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index-
=4&t=1s

3. Leading lines
Leading lines are actual lines or imaginary ones in a shot, 
that lead the eye to key elements in the scene or connect a 
character to other essential subjects. Whatever your eye is 
being drawn to in a scene, leading lines (indicated in yellow 
below) probably have something to do with it.

‘Parents Inc’

https://www.youtube.com/
watch?v=QMGWDiqWRDA&list=PL3PLBv5OrbIpuYhim35X-
KkIzwhbiBGey_&index=5

https://www.youtube.com/watch?v=xtdaQpE5kCY&list=PL3PLBv5OrbIpxFFDcwMRMKFcbAFA1bXVx&index=4&t=12s
https://www.youtube.com/watch?v=xtdaQpE5kCY&list=PL3PLBv5OrbIpxFFDcwMRMKFcbAFA1bXVx&index=4&t=12s
https://www.youtube.com/watch?v=xtdaQpE5kCY&list=PL3PLBv5OrbIpxFFDcwMRMKFcbAFA1bXVx&index=4&t=12s
https://www.youtube.com/watch?v=I1uHvlkLzTg&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=4&t=1s 
https://www.youtube.com/watch?v=I1uHvlkLzTg&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=4&t=1s 
https://www.youtube.com/watch?v=I1uHvlkLzTg&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=4&t=1s 
https://www.youtube.com/watch?v=QMGWDiqWRDA&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=5
https://www.youtube.com/watch?v=QMGWDiqWRDA&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=5
https://www.youtube.com/watch?v=QMGWDiqWRDA&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=5


5. 180% rule
This is a guideline that says that if you have two characters 
in a scene together, the one that is on the left should stay 
on the left of their fellow character, while the other character 
should stay on the right.
If you draw an imaginary line between the two subjects your 
camera shots should always be on one side of line.
If the camera were to cross the line, the audience could be 
confused as the characters in a conversation would appear 
on the “wrong” side of the frame. 
You will find a diagram on the next page that illustrates this 
concept.

4. Head room 
When framing a mid shot, head room is the amount of room 
above the subject’s head. It balances out the frame, makes 
the viewer feel at ease and keeps the focus on the eyes of a 
subject.

‘Console Me’

https://www.youtube.com/watch?v=AK17n-N2w-
jc&list=PL3PLBv5OrbIpxFFDcwMRMKFcbAFA1bXVx&in-
dex=1

https://www.youtube.com/watch?v=AK17n-N2wjc&list=PL3PLBv5OrbIpxFFDcwMRMKFcbAFA1bXVx&index=1
https://www.youtube.com/watch?v=AK17n-N2wjc&list=PL3PLBv5OrbIpxFFDcwMRMKFcbAFA1bXVx&index=1
https://www.youtube.com/watch?v=AK17n-N2wjc&list=PL3PLBv5OrbIpxFFDcwMRMKFcbAFA1bXVx&index=1


Very long shot

2. Shot size

What is shot size?
Shot size describes how much of the scene is included in 
the picture, and whether it mainly shows the setting, people 
in the setting, or details of faces and things. It is important to 
vary shot sizes to create visual interest and impact.
Below you will find nine different shot sizes from the film 
‘Autism Ability’. You can view the film at the following link:

https://www.youtube.com/watch?v=cY-Q6WsEkSE

Extreme long shot

Long shot

Medium long shot

Mid shot

https://www.youtube.com/watch?v=cY-Q6WsEkSE 
https://www.youtube.com/watch?v=cY-Q6WsEkSE 


Close up

Big close up

Medium close up

You can also download these shots as an A4 mini-poster. It 
may help to stick it on a wall and refer to it as you plan your 
storyboard or shots on location.

Extreme close up

https://static1.squarespace.com/static/5f-
36585c99bf563f56a3f220/t/616130d4b-
168ce22e6cb0055/1633759448049/Camera+shots.pdf

https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/616130d4b168ce22e6cb0055/163375944
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/616130d4b168ce22e6cb0055/163375944
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/616130d4b168ce22e6cb0055/163375944


3. Camera angle

Once you’ve decided on a shot size, you can add a bit more  
to your scene by choosing a particular camera angle. 

What is a camera angle?
The camera angle describes the way you position a camera 
in space to shoot a particular scene. It can be higher or 
lower than or level with the subject.
Camera angles can be used to create positive and negative 
emotions. They can provide clarity or bring confusion to the 
viewer. We will look at five of the most widely used camera 
angles:

1. Eye level
2. Low angle level
3. High angle level
4. Dutch tilt
5. Bird’s eye view

Under each explanation is an example from a film shown in 
the SDSW Film and New Media Festival.

‘Aspectrum What is Autism to Me?’

https://www.youtube.com/watch?v=zUZCtns-
88JY&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&in-
dex=5

1. Eye level
The most neutral camera angle is the eye level shot. The 
camera points straight ahead at about the same level as the 
subject’s face. The goal is to let the viewer follow the action 
without manipulating their emotions. While it’s called an eye 
level shot, it doesn’t have to be a shot of the character’s 
face. An object can be shot using this neutral camera 
angle. It is the most commonly used shot because it shows 
subjects as we would expect to see them in real life. 
Using this camera angle puts the viewer on an equal footing 
with the subject.

2. Low angle
This is the camera angle that looks up to the subject from 
a low position, and, therefore, can make them look bigger 
than they actually are. 
They can also appear threatening, dominant, or in a position 
of power over other characters.

https://www.youtube.com/watch?v=zUZCtns88JY&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&index=5
https://www.youtube.com/watch?v=zUZCtns88JY&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&index=5
https://www.youtube.com/watch?v=zUZCtns88JY&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&index=5


‘I Am a Very Special Being’

https://www.youtube.com/watch?v=Li0MOKY-
8Jgw&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V

3. High angle
The reverse of the low angle shot is the high angle shot. 
This shot shows the subject from above, i.e. the camera 
is angled down towards the subject. It has the effect of 
diminishing the subject, often making them appear less 
powerful, less significant or even submissive.

‘Yossernoons’

https://www.youtube.com/watch?v=cJE5ELnl-
57c&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&in-
dex=7

4. Dutch tilt
In this camera angle the camera is tilted and is not parallel 
to the horizon. It usually conveys a feeling of instability as 
it’s not a natural way to look at things. 

‘Phone Home’

https://www.youtube.com/watch?v=CX-
ghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGe-
y_&index=2&t=308s

5. Birds Eye view
This type of camera angle is shot from an extremely high 
position or directly above the subject. It often frames an 
entire location and is used as an establishing shot to situate 
the audience. 
It can be used to show the position and motion of different 
characters and objects also enabling the viewer to see 
things the characters can't.

https://www.youtube.com/watch?v=Li0MOKY8Jgw&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V
https://www.youtube.com/watch?v=Li0MOKY8Jgw&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V
https://www.youtube.com/watch?v=cJE5ELnl57c&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=7
https://www.youtube.com/watch?v=cJE5ELnl57c&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=7
https://www.youtube.com/watch?v=cJE5ELnl57c&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=7
https://www.youtube.com/watch?v=CXghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=2&t=308s
https://www.youtube.com/watch?v=CXghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=2&t=308s
https://www.youtube.com/watch?v=CXghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=2&t=308s


4. Camera movement

What is camera movement?
Camera movement is a shift in view, frame, or perspective 
caused by the movement of a camera. It enables the  
cinematographer and director to shift the audience view 
without cutting from one perspective to another using 
separate shots. Camera movements can make a film more 
emotionally and visually engaging.

What is the purpose of the camera movement?
1. The most common reason is to follow on-screen action.
2. To reveal or hide pieces of visual information in the scene. 
3. To highlight the emotional state of a character. 

The basic camera movements
The following camera movements can be accomplished 
using your smart phone and gimbal.
The first four are fixed shots involving subtle movements 
where the camera person doesn’t move while the last three 
involve the camera person moving with the camera.

1. Static
2. Zoom
3. Pan
4. Tilt
5. Tracking shot
6. Dolly shot
7. Follow shot

Under each explanation is an example from a film shown in 
the SDSW Film and New Media Festival. 
The time code after each title indicates where in the film the 
described shot takes place.

‘Radiance + Requiem’

https://www.youtube.com/watch?v=jn2d3hIg_
ME&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&in-
dex=8

https://www.youtube.com/watch?v=jn2d3hIg_ME&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=8
https://www.youtube.com/watch?v=jn2d3hIg_ME&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=8
https://www.youtube.com/watch?v=jn2d3hIg_ME&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=8


‘Critical Marx’ (0:12 - 0:18)

https://www.youtube.com/watch?v=tsm_xhpx-
UN4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&in-
dex=5

2. Zoom
The zoom shot is also a commonly used camera movement. 
It allows you to move closer to the subject without physically 
moving. It is important when using zoom to keep the 
movement as smooth as possible. We will show you how to 
zoom smoothly using the DJI smart phone gimbal.

‘The Hobbyist’ (0:33 - 0:36)

https://www.youtube.com/watch?v=p1TYND-
S0o20&list=PL3PLBv5OrbIrNGFKkmcNyvmUsK-
p3vwYX-&index=5&t=33s

1. Static
A static shot involves no camera movement. The camera is 
placed on a stable platform (often a tripod) and captures the 
action that occurs within the frame. This is the most used 
shot in film making and is the basis for the following three 
shots.

What is a tripod?
A tripod is a portable three-legged frame or stand designed 
to prevent camera shake by providing stability. Some smart 
phone gimbal packages include a mini-tripod that can be 
placed on a table or other flat surface to create stable shots.

https://www.youtube.com/watch?v=tsm_xhpxUN4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=5
https://www.youtube.com/watch?v=tsm_xhpxUN4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=5
https://www.youtube.com/watch?v=tsm_xhpxUN4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=5
https://www.youtube.com/watch?v=p1TYNDS0o20&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&index=5&t=33s
https://www.youtube.com/watch?v=p1TYNDS0o20&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&index=5&t=33s
https://www.youtube.com/watch?v=p1TYNDS0o20&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&index=5&t=33s


‘In the Deep’ (0:14 - 0:18)

https://www.youtube.com/watch?v=tjH-xNF-
W0Ig&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&in-
dex=3

5. Tracking shot
A tracking shot is a shot that follows alongside a subject 
throughout a scene, keeping them in the frame.
Tracking shots will generally follow the subject across the 
frame along the horizontal axis.

‘I Am a Very Special Human Being’ (3:21 - 3:25)

https://www.youtube.com/watch?v=Li0MOKY-
8Jgw&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&in-
dex=1&t=27s

3. Pan
A pan shot is a horizontal camera movement where the 
camera pivots left or right while its base remains in a fixed 
location. This shot is often used to reveal a larger scene or 
something off screen. We will show you how to pan very 
smoothly using the DJI smart phone gimbal later in this 
section.

‘The Loop’ (15:57 - 16:08)

https://www.youtube.com/watch?v=WSMgq-
W4eu9Q&list=PL3PLBv5OrbIo2RL1Bxe_HWzA-
We0x-45_V&index=4

4. Tilt
A tilt shot is one in which the camera stays fixed but rotates 
up and down on a vertical plane. It is similar to the motion of 
an individual raising or lowering their heads. It can be used 
to reveal a subject from top to bottom or the reverse. We 
will show you how to tilt very smoothly using the DJI smart 
phone gimbal later in this section.

https://www.youtube.com/watch?v=tjH-xNFW0Ig&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&index=3
https://www.youtube.com/watch?v=tjH-xNFW0Ig&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&index=3
https://www.youtube.com/watch?v=tjH-xNFW0Ig&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&index=3
https://www.youtube.com/watch?v=Li0MOKY8Jgw&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&index=1&t=27s
https://www.youtube.com/watch?v=Li0MOKY8Jgw&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&index=1&t=27s
https://www.youtube.com/watch?v=Li0MOKY8Jgw&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&index=1&t=27s
https://www.youtube.com/watch?v=WSMgqW4eu9Q&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&index=4
https://www.youtube.com/watch?v=WSMgqW4eu9Q&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&index=4
https://www.youtube.com/watch?v=WSMgqW4eu9Q&list=PL3PLBv5OrbIo2RL1Bxe_HWzAWe0x-45_V&index=4


7. Follow shot
A follow shot is a shot where the camera continuously 
follows the subject’s action. The camera can be behind or 
in front of the subject as it moves. If you want to achieve a 
smooth, seamless follow shot, a gimbal is very useful tool. 

‘Hyper Active’ (0:12 - 0:17)

https://www.youtube.com/watch?v=olCuB8ejf-
W4&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&in-
dex=2

6. Dolly shot
A dolly shot is one in which the camera moves toward or 
away from the subject you’re shooting. Instead of using 
the camera’s zoom function to get closer, the camera is 
physically moved towards or away from the subject usually 
along a track laid before the scene is filmed. A gimbal can 
mimic such shots.

‘Whichiswhich’ (0:04 - 0:06)

https://www.youtube.com/watch?v=I1uHvlkLzT-
g&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=5

https://www.youtube.com/watch?v=olCuB8ejfW4&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&index=2
https://www.youtube.com/watch?v=olCuB8ejfW4&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&index=2
https://www.youtube.com/watch?v=olCuB8ejfW4&list=PL3PLBv5OrbIrNGFKkmcNyvmUsKp3vwYX-&index=2
https://www.youtube.com/watch?v=I1uHvlkLzTg&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=5
https://www.youtube.com/watch?v=I1uHvlkLzTg&list=PL3PLBv5OrbIpK3G0gxsR7nqjHjDuKUy17&index=5


Adjusting the white balance in camera settings changes the 
way the camera processes an image to compensate for the 
different color temperatures emitted by various light sources. 
This is more difficult in smart phone cameras.
So in order to avoid unusual color variations between shots, 
you’ll need to give the your smart phone camera a common 
reference point every time you shoot something. 
Find an object that is naturally white. You can use a sheet of 
white paper as white balance cards can be quite expensive. 
(Perhaps something to invest in a little later in your film 
making journey.)
Film the white paper at the start of every shot so that when 
you come to editing you have a common reference point, 
the same sheet of white paper, that will assist you in the 
editing process to match colour across all your shots.
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5. Colour

The use of colour can be easily overlooked as an element of 
cinematography. 
While some decisions may be made by the director and 
other crew members, the way that color is handled on 
camera is a vital part of the cinematographer’s role. We will 
look at the technical and creative aspects of colour.

Colour temperature and white balance
First, you’ll need to understand the color temperature of 
your shot. Fluorescent light, tungsten light and natural light 
all have different color temperatures, as do clouds, shade, 
and direct sunlight.
Most cameras have built-in settings to adjust to a variety of 
light conditions.
If you aren’t using automatic settings and I recommend that 
you don’t, then you’ll need to understand a little bit about 
color temperature and how to properly white balance your 
shot.

What is kelvin?
The term ‘kelvin’ refers to the unit of measurement of color 
temperature. Every source of light emits light at a specific 
color temperature which can be measured in degrees kelvin 
or ‘K’. The color temperature of a light source varies from 
red to blue.
The higher the color temperature, the image will have more 
of a blue tint. A lower color temperature, such as that from 
tungsten light, will produce an orange hue.
The hue of a light source is measured in degrees Kelvin, 
and typical light sources range from 1000K (the flame of a 
candle) to 5000K (fluorescent light) to 15,000K (clear sky). 



2. Colour enhances mood and emotion

‘Autism Awareness - A Hate Crime’

https://www.youtube.com/watch?v=c2J7-J8Qf-Q

What is mood in film?
Also known as tone, the mood of a film can be dramatic, 
scary, funny, romantic, etc. This is why it’s so important to 
know how to achieve the right tone using colour, because it 
plays such a vital role in telling your audience how to feel. 
Mood is concerned with the overall feel of a film.

What is emotion in film?
Emotion is concerned with the inner feelings of the 
characters in a film. They can also have a powerful effect on 
the viewer.

The creative use of colour
The following part of this section is not the final word on 
colour in film. It is merely an introduction to get you thinking 
about colour and how you can use it to tell your story.
Over the next few pages we will look at some films from 
the SDSW Film and New Media Festival and observe their 
makers use of colour and how it has enhanced their story 
telling. 

1. Colour attracts the eye

In ‘Gardening’ the overall colour palette is various shades 
of green ranging from blue green to grey green to bright 
green. This is called a limited palette as it is limited to a 
small range of colours or in this case one colour. This 
palette acts as a backdrop to the action and characters. 
So a different colour is going to stand out, particularly one 
like yellow. When the sunflowers appear in frame with their 
bright yellow petals the eye is immediately drawn to them. 
That’s really important because one of the sunflowers is a 
key ‘character’ and a surprising one at that!

‘Gardening’

https://www.youtube.com/watch?v=r6nicva252c

https://www.youtube.com/watch?v=c2J7-J8Qf-Q
https://www.youtube.com/watch?v=r6nicva252c


‘Radiance + Requiem’

https://www.youtube.com/watch?v=jn2d3hIg_ME&t=431s

In the central part of ‘Radiance +Requiem’ we see the 
aftermath of a nuclear war. The earth has been destroyed. 
To decribe this terrible future the film maker has chosen a 
sepia stained look. 
In the last section of the film the filmmaker paints a more 
hopeful tone as he describes what qualities must be present 
in human beings to avert this disaster. It appears to be 
another time, perhaps even a different place to that seen 
in the central act. The colour palette contains the bright 
colours of a child’s chalk drawing and reflect a more hopeful 
time and place for the young.

3. Colour describes time and place

In ‘Autism Awareness - A Hate Crime’ the film opens with 
quite a joyful atmosphere. We see a colourful classroom and 
the students in the foreground of the shot wearing colourful 
clothes. The entire scene is dominated by bright red, blue 
and yellow. 
That all changes when the teacher is called out of the 
room. We soon realise we are looking through the eyes of 
a student (with autism) at the back of the classroom. The 
other students turn round and begin to torment him.
All of a sudden the scene reflects a drawing he has recently 
done. The students take on demonic qualities and flames fill 
the frame. It is the colour red that conveys so much of the 
emotions, hate and fear, that dominate.
While many elements make up the dramatic change of 
mood and emotion the change in colour conveys much of it.

Colour can describe a  time or place. 
When attempting to decribe a different time, particularly 
flashbacks, filmmakers will sometimes change the entire 
colour scheme of a scene to differentiate it from the present.
When attempting to describe a place colour can have a 
tremendous impact. A beautiful place such as a country 
town may be filmed and edited in soft pastel colours to 
enhance that beauty. 
A bleak desert landscape at midday may be filmed in 
washed out colour to describe the heat and stress any 
characters within that landscape might experience.

https://www.youtube.com/watch?v=jn2d3hIg_ME&t=431s


5. Lighting

All the elements of cinematography so far concern the 
understanding and use of the camera. The last element 
of cinematography is something that happens outside the 
camera; lighting. The use of this element has a profound 
impact on the look of your film. We will look at this in greater 
depth in section six; ‘Lighting’

4. No colour (black and white) 

‘Opposable’

https://www.youtube.com/watch?v=ZeBfqKGfk8c&t=107s

Although we have looked at how the use of colour can 
impact the way the filmmaker tells their stories and connects 
with their audience it’s important not to overlook the impact 
of no colour.
Of course black and white film was all that was available 
when the first motion picture (of a galloping horse) was 
created in 1878.
Black and white can be helpful in focussing the attention 
of an audience on the actors and their performance. An 
absence of the full range of colour can also be very pleasing 
to the eye as it forces the viewer to focus on the composition 
rather than the colours. It can also be used to create moods 
ranging from nostalgia to oppression. Black and white can 
be a very useful tool for your story telling.

‘Opposable’ is an experimental film that combines beautiful 
black and white imagery with a mysterious atmosphere. The 
filmmaker reflects on evolution, from the first primates to 
the human race. The lack of colour enhances that ancient 
process by allowing the focus to remain on the young 
actress and the superimposed images of monkeys. 

https://www.youtube.com/watch?v=ZeBfqKGfk8c&t=107s


1. Mobile phone holder
2. M3x0.5 screw hole
3. Tilt motor
4. USB-A port
5. Shutter/record button
6. USB-C charging port
7. M Button
8. Joystick
9 Battery level indicator
10. LED status indicator
11. Pan motor
12. Roll motor
13. Zoom slider
14. 1/4”-20 UNC port
15. Lanyard hole
16. Trigger

What is a gimbal?
In photography and videography, a gimbal is an apparatus 
that allows a camera to remain stable while the user is hold-
ing it. If you’ve used your smart phone for video you know 
that even with built in stabilisers the footage is still quite 
shaky.
Most modern smartphone gimbals are motorised and will 
stabilise video. On the following pages you will learn how to 
use the DJI Osmo Mobile 3 gimbal and the DJI Mimo App 
that interfaces with your phone.

Understand your DJI Mobile 3



STEP 2
Ensure Wi-Fi and Bluetooth are activated on the device.
For your gimbal to work with your smartphone, it needs to 
be connected via ‘Bluetooth’ and ‘Wi-Fi’. 
You can check these under under ‘Settings’.

STEP 3
Open the DJI Mimo App on your phone.

How to set up your DJI Mimo App

STEP 1
Download the DJI Mimo App for the iPhone at:

https://apps.apple.com/app/id1431720653

or for an Android phone at Google Play:

https://play.google.com/store/apps/details?id=dji.mi-
mo&hl=en_AU&gl=US

(Unfortunately the DJI Mimo App for Android does not have 
as many features as the one available for iPhone.)

https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/6137f4bad7c08d36976599ed/1631057082795/Osmo_Mobile_3_Mobile_Phone_Compatibility_List_en.pdf


STEP 5
Insert the phone into the gimbal and balance the device. 
Make sure the camera lens of your phone is on the side of 
the red arrow.
Mount the smartphone on the gimbal before powering on the 
gimbal. It should be in the centre of the holder as indicated
in the photo below.

STEP 6
Turn on the gimbal by pressing the ‘M’ button.

STEP 4
Agree to the terms of use. 

The ‘DJI Mimo App’ will open.



To allow the ‘DJI Mimo’ access to ‘Bluetooth’ click on 
settings/DJI Mimo and make sure ‘Bluetooth’ is on.

Return to the ‘DJI Mimo App’, tap the camera icon again and 
allow the ‘DJI Mimo’ access to your camera by pressing ‘OK’ 
on the pop up screen.

The following screen should pop up to indicate that your 
device is connected. 

The last step is to allow access to your gallery so that 
you can store your video in ‘Photos’ on your phone. Tap  
‘Settings’. 

STEP 7
Once the DJI Mimo App is open, tap the camera icon in the 
top left corner of the screen.

STEP 8
Connect the phone to the gimbal. There are quite a few 
permission screens that you will have to click through. Work 
through them one by one.

Click settings

Make sure your device is indicated under ‘My Devices’ and 
that ‘Bluetooth’ is turned on.



How to use your phone and gimbal
Now you have set up the DJI Mimo App on your phone and 
are connected to your gimbal it’s time to film!
The following instructions will help you get started.
When you open the Mimo app, if it’s already connected to 
the gimbal, then it should automatically switch to the camera 
interface of the app. 
You can always switch back to the home page by tapping 
the small house shaped icon in the corner.

STEP 1

Set the app to Video. You can change the settings using the 
slider below the large red record button. In this image the 
camera is already set to video. It is highlighted in yellow.
(When you first turn on the phone and gimbal the phone will 
be vertical).

Tap on the ‘All Photos’ tab so that your phone can store 
video from the ‘DJI Mimo App’ in ‘Photos’.



STEP 3

Now it is time to set up your camera. We will look at the first 
two icons under the home menu on the left hand side of the 
screen.

1. Set your exposure

What is exposure?
Exposure is the amount of light allowed to hit the image 
sensor of your camera while capturing video.

Tap on the first icon under the home symbol. it will either 
be an ‘M’ or ‘AUTO’. You can have manual or automatic 
exposure settings. 
The following menu will pop up. 

STEP 2

To move the camera from the portrait to the landscape 
position double click the ‘M’ button on the handle of the 
gimbal. The phone will automatically rotate.



Set Resolution to 3840 X 2160 and the “Video Frame Rate’ 
to 24.

Now you are ready to shoot some footage!

STEP 4: Camera controls

1. Record
Before we do lets look at the control panel again. Press the 
button highlighted in red to start record.

Set ‘ISO’ to 100 and ‘Shutter’ to 1/50 when shooting inside. 
EV will automatically adjust to give you a correct exposure 
so that the video will not be too dark or light.
(Android phones are always set to automatic.)

2. Set your resolution video frame rate (FPS)

What is resolution?
Resolution refers to the number of pixels on a display or in 
a camera sensor (specifically in a digital image). A higher 
resolution means more pixels and more pixels provide the 
ability to display more visual information (resulting in greater 
clarity and more detail).
For example in the image that follows the resolution is 
set at 3840 X 2160 pixels. (This is also known as 4K.)

What are frames per second?
Also known as frame rate and expressed as FPS (frames 
per second) the frequency (rate) at which consecutive 
images (frames) are captured or displayed.
For example in the image that follows the FPS is set at 24.
Television and movies are usually shot at this frame rate.



3. Zoom

What does zoom mean?
To zoom means to make your subject larger in the frame, 
without actually moving yourself and the camera forward.
Instead zoom in out out using the lens.

The zoom button is positioned on the side of the grip. It is 
highlighted in the image below.

If you push the button up towards ‘T’ (tight) you will zoom in 
i.e. make the subject in camera larger. If you pull the button  
down towards the ‘W’ (wide) you will zoom out i.e. make the 
subject in camera smaller.

4. Stop

Push the record button again and the video will stop 
recording. Your video will automatically save in your ‘Photos’
folder.

2. Pan and tilt

What does pan mean?
A pan shot is a horizontal or vertical camera movement 
where the camera pivots left or right  or up or down while its 
base remains in a fixed location. The term “pan” comes from 
the word “panorama,” a view so vast you have to turn your 
head to see it all.

What does tilt mean?
A camera tilt is a vertical movement in which the camera 
base remains in a fixed location while the camera pivots 
vertically.

If you push the button up or down the camera will move up 
and down (tilt). If you push the button left or right the camera 
will move left or right (pan). You may want to position your 
camera in this way before you start recording particularly if 
you are using a tripod and therefore have a fixed shot.



STEP 6: Export your video

You are now going to export the video or videos to your 
Mac. Click on the thumbnail of your video if you are sending 
one video. 
Then tap on the arrow on the bottom left hand corner of the 
screen.

Make sure ‘Airdrop’ is enabled on your Mac and tap the 
‘Other People’ icon on your iPhone. Make sure it is your 
computer that is listed! There can be other Apple devices 
around.

STEP 5: Locate your video

Tap on the photos file icon. You will find your videos there.

(To send multiple videos tap ‘Select’ and then click on the 
video files you want to transfer. A tick will appear on each 
file.)



File management
As mentioned previously it is so important to consistently 
back up your work. Many have lost work at some point in 
time because a computer has crashed or glitched. 
You should save all you work on a semi regular basis 
during production in at least two places. For ‘Phone Home’ 
everything was saved on a computer and a hard drive or 
large USB. If you have fast internet speeds it is worth saving 
footage on a cloud server such as Drop Box or iCloud. Your 
work is too valuable to lose.

Here is the file template that was introduced at the end of 
the story section. 
Save your footage in the ‘Video’ folder. Create sub folders 
within this folder for each scene so that when you come to 
edit the footage you can find all your footage easily. It will 
save you a lot of time.

It is important to come up with a labelling system for each 
clip that makes it easy to find and use later on.
You could label the first clip:
Scene_1_Take_1
and so on and so on.

A dialogue box will now pop up in the right hand corner of 
your Mac screen. Tap ‘Accept’. 

Choose where you want to save the video or videos. Tap 
‘Open in Photos’ or “Save to Downloads’.

You have now transferred your vidoes from your iPhone to 
your Mac.



Save your green screen footage in the ‘VFX’ folder.
Once again label your video files in a way that will make 
them easy to find at a later time.





sound

Sound is half of your finished product. It is so important to 
make sure that you have the best quality sound available. 
The closer the microphone is to the actor or speaker, the 
better the sound quality.
Generally the sound recorded by your smart phone 
microphone will not be good enough to use in your finished 
edit. You will need it to align the better quality audio.
You will need an exterior microphone and a recording 
device. In the equipment section there are details for a 
lavalier kit. To keep costs down use a smart phone as  a 
recording device. 

There are two alternatives to using an exposed lavalier
microphone:
 1. Additional Dialogue Replacement (ADR). This will 
be discussed in more detail in the post section. It basically 
involves re-recording the actors dialogue in the studio after 
the video shoot.
 2.  Hide the lapel microphone on the body so that it is 
out of sight. Later on in this section we will show you how to 
do this.

A lavalier microphone needs a recording device attached 



This set up is great for interviews where it is perfectly 
acceptable for a small microphone to appear in shot. For 
narrative films you can still use the lapel microphone but will 
have to tape it to the inside of the shirt.
Remove the microphone from the clasp and use tape that 
can stick to clothing. It should look something like this before 
you do up the shirt:

In order to hide the recorder (in this case an iphone) on 
the talent you will need something to attach the recorder 
to their body. A runner’s belt (pictured below) that consists 
of a zip up pouch attached to a polyester buckle belt can 
carry the largest mobile phone. This one cost $8 from a local 
department store.

to it. The cheapest way to go is to use an iphone that is not 
being used for filming. 
The following instructions use the iphone but most android 
devices have some sort of in built recording application.

STEP 1: Attach the microphone to the talent

As mentioned earlier there are at least two ways to set up 
the lapel microphone on the talent. The first method is the 
traditional method where an interview is being recorded.Clip 
the lapel microphone to the shirt or blouse about 20 to 30 
centimetres from the mouth, running the microphone cable 
behind the shirt. You will clip the microphone to the collar if 
the talent is wearing a t-shirt.



STEP 2: Plug the microphone into your iPhone

Plug the RODE smart lav microphone into your iPhone 
headphone jack as indicated below.

Step 3: Record the talent

With the Voice Memos app, you can use your iPhone as a 
portable recording device to capture the actor’s dialogue. 
You will find the Voice Memo app in the Utilities folder of 
your iPhone. 
Before you do this you need to make sure that the audio 
quality is set at the highest quality possible. 
To do this go to settings and tap the Voice Memo tab.

Unzip the pouch and attach the microphone cable to the 
phone.

Zip up the pouch enough so that the phone doesn’t fall out 
but the zip doesn’t pinch the cable. 20mm gap should be 
about right. Buckle the runners belt to the talent under their 
shirt. Position it to the side if you are filming an 
interview or a scene for a narrative film where any bulge 
from the pouch will not be seen. If you are filming a scene 
where the talent is standing and moving, place the pouch in 
the small of the back as indicated below. It is virtually 
undetectable.

When everything is in place zip open the pouch enough to 
open the Voice Memo app and hit record. Zip everything 
up again and straiten the talen’t clothing. Obviously you will 
record audio before you are ready for them to answer ques-
tions or say their lines but this can be edited out later.



Now go to the ‘Voice Memo’ app on your phone. You will find 
it in the ‘Utilities’ folder.

Tap on the ‘Voice Memos’ app.
Tap on ‘Audio Quality’ and make sure ‘Lossless’ is ticked.

This will bring you to the ‘Voice Memos’ settings.

This will give you a better quality file although the  file size 
will be larger. Make sure you save the recordings from your 
phone onto a computuer and hardrive on a regular basis. 
You will then be able to clear sound files from your phone 
freeing up space for the larger ‘lossless’ files.



Rename the file in such a way that you can reference it 
easily when you begin to edit.
For example:
James_Scene4_Take1

Export the recording to your computer via email or with 
Airdrop if you have a Mac. You can send all the recordings 
from a particular session at one time if you would like. Just 
select each sound clip before you send.

Tap the record button and place the phone out of sight of the 
camera. Your screen will look like the image below.

Tap the record button again to stop the recording. The file of 
your new recording file appear on screen.
If the location service is turned on, the recording will be 
named after that location.



Place it in the ‘Audio’ folder under ‘Recordings’ that you 
have already prepared.

Convert audio imported from your iPhone
Before you start your edit you will have to turn the audio files 
you have imported from your iPhone from the .m4a format 
to the .wav format. 
Premiere Pro does not recognise the .m4a format so it 
will have to be changed to a .wav format before it can be 
imported into your project.

STEP 1: Find your airdrop confirmation

This will appear in the right-hand corner of your ‘Desktop’.
Click accept.

STEP 2: Find your file in downloads.

This will be appear in the right-hand corner of your ‘Desktop’ 
after you click ‘Accept’.



STEP 6: Navigate to ‘File/Convert/.

Click on Create WAV Version.

STEP 7: Find the WAV file.

The .wav file will appear with the same name below the 
.m4a file.

STEP 3: Drag the file to the ‘Desktop

It will look like this:

STEP 4: Open ‘iTunes/Songs’

STEP 5: Drag the file into ‘Songs’.



1. YouTube music
If you want to monetize a video on YouTube, you can’t use 
a song that’s copyrighted by another party. If a song is copy-
righted, YouTube’s Content ID system can block your video 
or put copyright-specific advertising over it.

Sign in to YouTube Studio
You must have a YouTube Studio account. You will find out 
how to do this in the Distibution section.

From the left menu, select ‘Audio Library’.

You can also access the ‘Audio Library’ directly at:

youtube.com/audiolibrary

Now we turn to the other elements of sound, Music, Sound 
Effects and Voice Over. This can be done as you edit.

Music
Music helps to tell the story of a film. Filmmakers can use it 
to build tone and mood including tension and even horror. 
It can also describe the feelings of characters and reinforce 
their actions. Music can create atmosphere and turn a good 
film into a great one. 
You will find a number of free and paid versions on the 
following pages.

STEP 8: Drag the file to the ‘Desktop’.

It will look like this.

STEP 8: Save the file.

Drag it to your pre-prepared files.
Now it will be ready to import into your Premiere Pro project.

http://youtube.com/audiolibrary


Refine your search results by clicking the filter  next to the 
artist, genre, or mood of individual tracks. You can sort your 
search results by track title, artist name, duration, or date by 
clicking their column names. 
An example of filtering according to ‘Genre’ is below:

Save your favorite tracks by clicking the star icon next to the 
track title. 

To see a list of your favorite tracks, click the Starred tab.

To download a track scroll over ‘Added’ and click 
‘Download’.

Search the Audio Library
Find ‘Free music’

In the Free music tab, use the filters  and search bar to find 
tracks for your videos.



You can start a subscription here:

https://audiio.com/pricing

Sound Effects

What is a sound effect?
A sound effect is a sound recorded and edited for a specific 
storytelling or creative point without the use of dialogue or 
music. These sounds include everything including noises 
made by people and nature. They need to sync exactly with 
the image.

The person who creates and records these sounds is known 
as a foley artist. (They are named after Jack Foley who 
created sounds for films until his death in 1967.) They will 
often watch the film and create the sound effects live.

While films with serious budgets are able to create these 
sounds for the independent film maker their are a number of 
options.

1. YouTube
YouTube has a library of sound effects available for free.
Follow the instructions for music to access sound effects.

2. BBC sound effects library
Has over 30,000 sound effects.

The link is below:

https://sound-effects.bbcrewind.co.uk

2. Epidemic Sound 
$15 US per month 
You only have to subscribe for as long as it takes you to 
upload your film to You Tube, Facebook etc. If you upload 
your film during the subscription period the production music 
is licensed for that film as long as it is online. 

You can start the subscription process here:

https://www.epidemicsound.com/subscriptions/create/

If you cancel the subscription within the first thirty days 
you will not have to pay anything but you will still be able 
to access the site and download songs using your original 
login details. (But don’t upload any tracks to You Tube etc. 
unless you renew your subscription.)

3. Audiio
You can get a lifetime subscription for all their music for 
$299 USD. It is a large upfront cost but if you are serious 
about continuing your film making journey the positive is that 
you never have to go through the licensing rigmarole for any 
of your projects. 

Your track will be available in your ‘Download’ tab on the 
right hand corner of the desktop.

New releases are added to the Audio Library twice a month.

https://audiio.com/pricing
https://sound-effects.bbcrewind.co.uk
https://www.epidemicsound.com/subscriptions/create/


Save these tracks in the ‘Audio’ file you have already 
prepared.

This sound effects library is free to use but cannot be used 
for commercial projects unless you get their permission and 
possibly pay a fee. 

Their terms and conditions are at the link below:

https://sound-effects.bbcrewind.co.uk/licensing

3. Epidemic Sound
You can access the sound effects from the account you 
have opened for music. Epidemic Sound has over 90,000 
special effects.

4. Audiio
Audiio already has 30,000 special effects and is adding 
more all the time. A lifetime subscription for their special 
effects package is $199 USD. 

You can sign up for a lifetime sound effects subscription at 
the links below:

https://audiio.com/sound-effects

Voice-over

What is a voice-over?
Voice-over is dialogue from an unseen, offscreen voice, 
character, or narrator.

Record voice-over in the same way you record regular audio 
from you actors. Just make sure that you are in a quiet 
location that is relatively free from background noise.

https://sound-effects.bbcrewind.co.uk/licensing
https://audiio.com/sound-effects




lighting

Lighting can make or break your film. It can create or kill a 
mood or a performance. Lighting can seem very intimidating 
when you first try to set it up but in this section you will learn 
a technique that is used in all visual media. It is known as 
three point lighting.

What is Three Point Lighting?
Three-point lighting is used in theatre, video, film, still 
photography, computer-generated imagery and 3D 
computer graphics. It is a simple but versatile system that 
forms the basis of most lighting. Once you understand three 
point lighting you are well on the way to understanding all 
lighting and will inderstand how to adapt it for your film.
This set up uses three lights known as the key light, fill light 
and back light. Naturally you will need three lights to do this. 
But understanding the principles will enable you to light your 
subject using one or two lights. 
If you only have one light, it becomes the key.
If you have 2 lights, one is the key and the other is either the 
fill or the backlight.
The following illustration shows you the basic set up.



the subject from the background by creating a rim of light 
around the subject. For this reason it is also known as the 
rim light.
In the equipment section there are a number of lighting 
recommendations if you can’t afford studio lighting. The 
principles for lighting with each will remain the same.

Hard and Soft Lighting
In film, video, and photography, there are two major 
categories of light: hard light and soft light. You can work 
out whether your light source is hard or soft by looking at 
the shadows. Hard lights will have shadows with very sharp 
edges, whereas soft light will have shadows with soft edges 
or no defined edges at all.
The thing that makes a light either soft or hard is the relative 
size of the light source. A small source will be much harsher 
than a larger source. The best example of this is the sky. 
On a bright and sunny day, your shadows will be incredibly 
sharp because the light source that illuminates the subject 
(the Sun) is relatively very small in the sky.
Contrast a sunny day with a cloudy day. On an overcast 
day, you no longer have a strong single point light source 
illuminating your subject, rather the light is diffused across 
the entire sky. Such conditions produce very soft shadows.

Why Soft Lighting?
While one type of light source is not better than the other, 
hard and soft lights can create very different moods. Soft 
light is also easier to work with than hard light. 
There are a number of reasons for this.
First, soft light doesn’t create sharp shadows in the way that 
hard light does. 
By nature, our eyes are drawn to high contrast. If you’re us

Key Light
This is the main light. It is usually the strongest light and 
has the most influence on the look of the scene. It is placed 
to one side of the camera/subject so that this side is well lit 
and the other side has some shadow.

Back Light
The back light is placed behind the subject and lights it 
from the rear. Rather than providing direct lighting (like the 
key and fill), its purpose is to provide definition and subtle 
highlights around the subject's outlines. This helps separate 

Fill Light
This is the secondary light and is placed on the opposite 
side of the key light. It is used to fill shadows created by the 
key. The fill will usually be softer and not as bright as the 
key. To achieve this, you could move the light further away 
or use a diffuser. We will look at this in more detail soon. 

Camera

Key light

Back light

Fill light



i. As a Key Light
As mentioned earlier the key light is your primary light. It 
clearly highlights the form of your subject. Now, if you find 
yourself on location with nothing but natural light, you can 
use a reflector instead of a key light. Place your talent with 
their backs to the sun. Then use the reflector to bounce the 
sunlight onto their face.

ii. As a Diffuser
At times you’ll find that you may have too much light. In this 
case you’ll want to diffuse that light so that your subject isn’t 
harshly lit.
If you’re working on location using natural light you can use 
the translucent side of a 5-in-1 reflector and place it be-
tween your subject and the sun to diffuse it. This will cast 
smooth light on your subject rather than the harsh light that 
you would have without it.

iii. To add Shadow
You can also use the your reflector as a shader because at 
times you will have too much reflected light and you may 
want more shadow. Place the black panel of your 5-in-1 
reflector between the reflective light source and the subject  
to achieve an even shadow opposite the key light.

iv. To create Rim Light
You can position the reflector to redirect light from one of 
your lights, particularly the stronger key light, if you only 
have two lights, to illuminate the back of the head to create 
a rim light.

ing hard lights, the viewer’s eyes may be drawn to points in 
the frame other than your subject. 
Soft light also helps make your subject look as good as 
possible by minimising wrinkles and blemishes.

How can you achieve soft shadows on set?

1. Diffusion Paper
Diffusion paper is a translucent paper that is a great option if 
you want to soften your lighting. It limits the amount of light if 
you place it between the light and the subject. The “paper” is 
usually clamped to the barn doors of a light. The result isn’t 
dramatic, but it is subtle enough to soften the shadows.
You can use wax paper or baking paper instead of diffusion 
paper to get a similar effect. These papers that are readily 
available from the supermarket will work with LED lights but 
shouldn’t be used with a tungsten light as they could catch 
fire.

2. Reflector
There will be times when on location you will only have 
natural light to work with. Other times the lights you have 
available are too bright and need some diffusion. A 5-in-1 
reflector can be a great tool to help tackle these issues.



Below are the two green screen images shot for the scene 
before they were edited.

Step 1: Build your Green Screen

We will look at two ways to create a green screen. The 
first is the use of chroma key paint. It can be purchased 
online and is great for a static, front on, medium shot. The 
draw back is that you will have to paint a wall. If you have a 
permanent place set up for shoots this is a great option.
The second involves using a piece of fabric suspended on a 
frame or taped to a wall. This is what was used for ‘Phone 
Home’. James and his father taped a lime green sheet to a 
large flat wall.

Green screen
Green screen allows you to shoot actors and objects and 
insert backgrounds behind them at a later date. You can 
film someone inside but then take the action outside. You 
can place them somewhere else altogether. There are 
many such shots in ‘Phone Home’ which was filmed in the 
middle of a pandemic where it was not possible to shoot on 
location. We also had trouble finding a flying bus so green 
screen had to do.
We have placed this subject in the ‘Lighting’ section 
because much of green screen success depends on 
effective lighting, building on what you have learnt in this 
section.

The still below from the ‘Phone Home’ flying bus sequence 
involved two images shot in front of a green screen. 
(4:22 - 5:22)

https://www.youtube.com/watch?v=CX-
ghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGe-
y_&index=2

https://www.youtube.com/watch?v=CXghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=2
https://www.youtube.com/watch?v=CXghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=2
https://www.youtube.com/watch?v=CXghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=2


or frame and one on the floor. It is important to stretch the 
sheets flat using gaffer tape to minimise wrinkles that cast 
deep shadows and are quite difficult to edit out in post 
production.

Step 2: Light Your Green Screen

Good lighting is critical when using a green screen to create 
an even colour and eliminate shadows.This makes the 
editing process a lot easier.
When lighting your green screen, a major issue is to avoid 
“green spill”. This happens when the colour of your screen 
taints everything around it with a green glow including your 
actors or objects.
The number one way to avoid this is to make sure you light 
both the screen and actor or object correctly. 
When lighting the backdrop, your goal is to not only 
illuminate the screen but also reduce shadows and wrinkles.
To light the backdrop, use two lights that are positioned at 
different angles, each a couple of feet from the screen about 
half-way up the screen. If you choose to go with a pull-up 
screen, collapsible backdrop or simply to paint the wall, 
getting rid of wrinkles won’t be a major issue, but you’ll still 
want to illuminate the backdrop as brightly as you can.
Once your backdrop is lit, it’s time to light your subject. If 
you can, use three separate lights; a key light, fill light and 
backlight. Your key light is the most prominent because it  
casts the most light on your subject.
Your fill light is softer and placed at an angle opposite to the 
key light. Its purpose is to fill the shadows caused by the key 
light. And finally, the blacklight helps to illuminate the edges 
of the performer. This is vital when using a green screen as 
it helps to clearly separate the subject from the backdrop.

You can also purchase a green screen frame and suspend 
your cloth or paper green screen as pictured below.

What’s great about the material option is that your green 
screen is now portable which gives you the ability to shoot 
green screen in different locations.

A blue screen might be the choice when you are filming 
foliage or green plants, or when your subject has light 
blonde or even white hair.
Whether you use green or blue screen make sure that you 
have a big enough area for the action required. If you’re 
shooting an action scene, you should use a much larger 
green screen sheet. 
This is so important because if the actor or object overlaps 
the edge of the green screen they will look “cut off” in post 
production.
When using a wide shot in which the actor’s entire body 
appears in the shot you will need to cover the floor around 
them. If you buy a sheet set, you can use one on the wall 



Step 3: Filming in front of a green screen

As with regular camera videography, try to avoid high ISO 
as you want to get the cleanest image possible without a lot 
of noise. Set it at 100. You’ll want to set your shutter speed 
as you normally would, 1/50. These setting will be fine for 
fairly static poses.

If your actors are making quick movements, up your shutter 
speed to 1/100 and your ISO to 200. The higher shutter 
speed will minimise blur but your picture may be a bit more 
noisy or grainy.Try not to go above ISO 200 when you are 
shooting inside.

Make sure that your lighting is also consistent with the 
background you use. You need to create similar lighting 
effects on your actor or object as is found in the background 
photo or footage. For example if the light is coming from the 
right hand side in the background photo/footage you need to 
key light your subject from the right hand side.

The image below illustrates the ideal set up.

Green screen

Camera

Key light

Back light

Fill light



Now that you’re camera is set up, here’s some tips when 
shooting with a green screen.
First of all make sure your subjects aren’t wearing any 
green. Those green items will also disappear when you edit 
the clips!
Actors should not be wear reflective jewellery or glossy 
makeup that may attract green spill. 
When working with a green screen, it’s essential that 
you know what action will take place and choreograph 
it perfectly so your performers are interacting with the 
background elements as they happen.

Step 4: Edit your green screen footage

You will find a step by step guide for this at the end of the 
‘Editing’ section.





editing

What is film editing?

Film editing is the art and craft of cutting and assembling 
a finished film. A film editor works with raw video footage 
to select shots and combine them into scenes in order to 
complete the project. Their goal is to fulfil the director’s 
vision. In low budget film making you may have both roles. 
The editor is not just a button pusher but an artistic partner 
and creative decisions are usually a collaboration between 
the editor and the director. This process is usually started 
and completed during post-production.

In this section you will look at how to create a film in 
Premiere Pro, one of the most popular editing software 
packages available.
They have a number of packages available. You can access 
them here:

https://www.adobe.com/au/creativecloud/plans.html

https://www.adobe.com/au/creativecloud/plans.html


STEP 1: Create a project

Launch Premiere Pro and click New Project in the ‘Start’ 
screen 

The ten steps of editing

STEP 1: Create a project
STEP 2: Import media
STEP 3: Sift and select
STEP 4: Shape the story with music
STEP 5: Colour correction
STEP 6: Colour grading
STEP 7: Sound design
STEP 8: Text
STEP 9: Transitions
Step 10: Export

This last step happens after the edit is completed and you 
will find the how to guide for this in the ‘Export’ section.

or choose File > New > Project from the main menu.



STEP 2: Import media 
Choose Window > Workspaces > Assembly. 

On the right hand side of your project is a large box with the 
words ‘Import media to start’ in the middle. 

In the ‘New Project’ dialogue box, name your project. 

Choose ‘Browse’ and navigate to the place where you want 
to save the project. This could be a previously prepared 
folder, the desktop or an attached drive.

Click ‘Choose’.

Drag your media files into this box from the desktop or you 
can import them via the drop down menu, File > Import.



Once your media is imported navigate to the ‘Editing’ 
workspace. Go to the menu at top of the screen and choose 
Window > Editing.

Your screen will now look something like this.

In order to edit effectively you really need to understand the 
basics of this editing workspace. You can find an A3 PDF 
on the ‘James Makes a Movie’ website page that labels the 
various parts of the ‘Editing’ workspace. In order to assist 
you while learning to edit, print out the poster and have it 
handy so that you can refer to it as needed.  
Click on the link below to download the PDF.

https://static1.squarespace.com/
static/5f36585c99bf563f56a3f220/t/61764d0a0d878d509437
41e0/1635142927924/Editing+workspace.pdf

Understand the ‘Editing’ workspace

Definition of terms for the editing workspace

A. ‘Source’ monitor
The ‘Source Monitor’ is used to playback and preview 
individual clips. You can also use the ‘Source Monitor’ 
to prepare clips before you add them to a sequence. In 
the ‘Source Monitor’, you can set In and Out points, add 
markers, and specify how the clip will be added to the 
‘Timeline’. You can drag and drop clips into the ‘Source’ 
panel or by double-click them to view them in this monistor.

B. ‘Effect Controls’ panel
Special effects can be added to video and audio clips on 
the ‘Timeline’. Some effects, for example, can change 
color video to black-and-white, while others alter the color 
balance of an image or can help to simulate the look of film. 
The ‘Effect Controls’ panel allows you to edit effects that 
have been applied to your clips. To access these, you click 
them to select. If you do not have a clip selected, the panel 
remains blank. You can also use the panel to access the 

https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/61764d0a0d878d50943741e0/1635142927924/Editing+workspace.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/61764d0a0d878d50943741e0/1635142927924/Editing+workspace.pdf
https://static1.squarespace.com/static/5f36585c99bf563f56a3f220/t/61764d0a0d878d50943741e0/1635142927924/Editing+workspace.pdf


Motion, Opacity, and Audio properties of clips.

C. ‘Audio Clip Mixer’
Use the ‘Audio Clip Mixer’ to adjust settings while listening 
to audio tracks and viewing video tracks. Each Audio Mixer 
track corresponds to a track in the Timeline of the active 
sequence. You can also use the mixer to add effects, 
change the volume of relative tracks, or to record audio 
directly into sequence tracks.

D. ‘Metadata’ panel
‘Metadata’ is the information that describes the content 
or properties of a file. Video and audio files automatically 
include information regarding their file size, format, creation 
date, and duration.
Metadata can also include additional information, such as 
location, director, scene, shot, etc. The metadata panel 
allows you to edit and view these properties so you can 
use them to organize and sort your files, or share with other 
Adobe applications.

E. ‘Program’ monitor
The ‘Program Monitor’ is the live monitor for your ‘Timeline’. 
Used it to playback and preview clips on the ‘Timeline’.

F. ‘Media Browser’ panel
The ‘Media Browser’ allows you browse and preview files on 
your hard drive. The Media Browser gives you quick access 
to all your assets while you edit.

G. ‘Info’ panel
The Info panel displays information regarding the currently 
selected item in the ‘Project’ panel or ‘Timeline’.

H. ‘Effects’ panel
The ‘Effects’ panel is the place you will find all available 
video and audio effects and transitions. You can place 
transitions such as Dissolves, Dip to Black, etc. between 
clips to allow you to transition from one clip to another. You 
can also add effects such as Black and White to individual 
clips, to change their appearance or audio quality.

I. ‘Markers’ panel
You can use the ‘Marker’ panel to see all the markers in 
an active clip or sequence. The panel displays marker 
information such as In and Out points, comments and color 
coding tags.

J. ‘History’ panel
The ‘History’ panel stores a list of the actions you have 
performed to change the state of your project in the current 
working session. As an alternative to using Edit > Undo, or 
the keyboard commands Ctrl+Z (Windows) or Cmd+Z (Mac 
OS), you can use this panel to jump back to any previous
state in the current work session. However, you should note 
that changes you make to the program that affect panels, 
windows, or preferences are not stored in the ‘History’ 
panel. Also, when you close and re-open Premiere Pro, the 
‘History’ panel is automatically reset and you lose access to 
the previous states of your project.

K. ‘Project’ panel
Video editing is a non-destructive editing process because 
you do not edit the original content of your files. The ‘Project’ 
panel contains references to all the footage files (video, 
audio and images) that you have imported into Premiere 
Pro in addition to the sequences, titles and other supporting 
material you create in the application.



L.Tools panel
This panel stores the various editing tools you can access 
in the application. The cursor changes appearance based 
on the tool that is active and the type of content that you are 
hovering over. We will explain these tools in greater deepth 
in the following pages.

M. Timeline panel
You perform the majority of your editing work on the 
‘Timeline’ panel, including adding clips, positioning them, 
and changing their properties. You can also use the 
‘Timeline’ to add effects and transitions to the video and 
audio clips in your project. Each sequence in the project is a 
separate, independent ‘Timeline’. When multiple Timelines 
are visible, the panel uses a tabbed display similar to a web 
browser to separate each.

N. Audio meters panel
This panel is a VU (Volume Units) meter. It shows the 
volume of clips that are on the ‘Timeline’. The display in this 
panel is active only when you preview the video and audio 
clips on the ‘Timeline’.

A. Selection tool

B. Track selection tool

C. Ripple Edit tool  

D. Razor tool

G. Slip tool

H. Pen tool. 

J. Hand tool

K. Type tool

Understand the ‘Editing’ tools

Now we will look at the tools you will regularly use to edit 
footage on your timeline.
You will find the Tool panel wedged between the ‘Project’ 
panel and the Timeline panel.

If you click on the arrows at the corner of the tools there are 
sub-menus. These tools tend to be used less.

Track selection tool
‘Track Select Forward Tool’ and ‘Track Select Backward 
Tool’



Ripple Edit tool
‘Rolling Edit tool’ and ‘Rate Stretch Tool’

Slip Tool
‘Slide Tool’

Pen Tool
‘Rectangle Tool and Ellipse Tool’

Hand Tool
‘Zoom Tool’

Type Tool
‘Vertical Type Tool’

Definition of terms for the editing tools

A. Selection Tool
Use this tool to select clips, menu items, buttons, and other 
objects found in the user interface. Most clips and interface 
interaction requires the use of the Selection tool.

B. Track Selection Tool
Use this tool to select all clips to the right of the cursor in a 
sequence. 

C. Ripple Edit Tool
You can use the Selection tool to trim the start or end of 
a clip in the ‘Timeline’; however, they will create an empty 
space between those clips. Use the Ripple Edit tool to trim 
the In or Out point of a clip. Close gaps caused by the edit, 
and preserve all edits to the left or right of the trimmed clip.

D. Rolling Edit Tool
Use this tool to simultaneously change the In and Out points 
of a pair of adjacent clips on the Timeline: the Rolling Edit 
Tool trims the In point of one clip and the Out point of the 
other clip, leaving the combined duration of the two clips un-
changed.

E. Rate Stretch Tool
This tool is used to shorten or lengthen a clip in the ‘Time-
line’. The ‘Rate Stretch’ tool speeds up or slows down the 
playback of the clip without trimming the clip. It leaves the In 
and Outpoints of the clip unchanged.

F. Razor Tool
Use this tool to split clips in the ‘Timeline’. Click any point on 
a clip to split it at that exact location. To split all clips across 
all tracks at an exact point, press and hold the Shift key 
while clicking a clip. 

G. Slip Tool
Use the Slip tool to simultaneously change the In and Out 
points of a clip in a ‘Timeline’, while keeping the overall 
duration of the clip unchanged.

H. Slide Tool
Use this tool to move a clip to the right or left on the Timeline 
while trimming any adjacent clips. The combined duration 
of the clips, and the location of the group in the ‘Timeline’, 
remain unchanged.

I. Pen Tool
The Pen tool is used to set or select key frames for clips in 
the ‘Timeline’.



J. Hand Tool
Use this tool to move the viewing area of a ‘Timeline’ to the 
right or left as an alternative to the scroll bar at the base of 
the Timeline panel.

K. Type Tool
The type tool allows you to quickly add type to your project.

STEP 3: Sift and select

During this step you will place and edit your footage on the 
‘Timeline’. The aim is to look at all the footage and discard 
what you don’t want and trim what you do.

Drag the clips from the ‘Project’ panel in the ‘Masters’ folder
onto your ‘Timeline’.



When you use ‘Ripple Delete’, the deleted clip is removed 
and the clips either side are joined.Line up all your clips in the order they will appear in the film. 

To do so select the clip you want to move and drag it into 
position. 

When this has been done scroll through each clip. You can 
grab the play head and move it along the clip or watch it in 
real time when you tap the space bar on your keyboard.

If you want to remove an entire clip select the clip, right-click 
the mouse and click ‘Ripple Delete’ in the drop down menu.

Timeline workspace

V1 
(Video track one) 

A1
(Audio track one)

Time code

Eye icon
(Show/hide video )

M
(Mute audio)

Video tracks are found above, and audio tracks below, the 
yellow dashed line. You can have as many video and audio 
tracks as you like. 

If you want to cut a clip, grab the playhead and move it to 
the point you want to cut. Click on the razor blade tool in the 
tool panel. It will look something like this on the ‘Timeline’.



STEP 4: Shape the story through music

Music can be such an important part of story telling. It is 
time to source the music you have chosen from sites such 
as ‘Epidemic Sound’. 
They should be in the ‘Music’ folder in the ‘Project’ panel. 
If you have not chosen your music, now is the time.

You can mute any tracks you are not listening to by clicking 
‘M’ to the left of that ‘Audio’ track. 

Play through the music tracks one by one until you feel as 
though you have found the music that enhances your video 
and therefore your story, and delete the rest.

Right-click on the mouse and click ‘Cut’.

You have now have divided the clip. As you have done 
before, select the unwanted section of the clip and click 
‘Ripple Delete’.

Work through all the clips on your ‘Timeline’ until you have 
removed all unwanted clips and are left only with the clips 
you need.
The reality is that you will probably need to do this a number 
of times as you continue to edit your film.

Drag the music onto the ‘Timeline” and position the tacks 
under the appropriate clips. They are highlighted in yellow.



STEP 5: Colour correction

What is colour correction?
Colour correction is a process that occurs during a film's 
post-production phase. The film makers use editing software 
to adjust the white balance, colour, contrast and exposure 
of film footage so that it appears natural and unprocessed, 
exactly the way the human eye sees them. 
Go to the colour workspace by clicking on the colour tab at 
the top of the editing workspace:

Your workspace will now look something like this:

At the far right of the colour workspace you will see the 
‘Lumetri Colour’ panel. Click on ‘Basic Correction and you 
will see the following interface: 

Drag the eye dropper tool onto a clip on the ‘Timeline’ that 
you would like to colour correct. Place it over the white card 
you included at the start of each shot. (You may have to go 
back and find those frames with the card in it. Otherwise 
look for something white in your footage and drag the eye 
dropper onto that.)
You will immediately see that the colours change. 



If you’re not satisfied with the look of the footage you can 
click on auto colour correct. The colours will adjust again. 

If you want to adjust the colours a little more, work your way 
down the sliders under ‘Basic Correction’. This is the best 
way to learn how each slider will effect your footage.

The sliders are; ‘Temperature’, ‘Tint’, ‘Exposure’, ‘Contrast’, 
‘Highlights’, ‘Shadows’, ‘Whites’, ‘Blacks’ and ‘Saturation’.
Click on the circle in the middle of each slider and drag it left 
and right until you are satisfied with the look of your footage.

If you feel unhappy with the result you can click ‘Reset’ and 
this will restore the footage to the original look. You can then 
start fresh.

STEP 6: Colour grading

Once you have corrected your colours it is time to grade 
them.

What is colour grading?
Colour grading is the process of stylising the colour scheme 
of your footage after you have colour corrected it. During 
colour grading, editors use editing software to emphasise 
the visual tone and atmosphere of a movie, making it look 
more cinematic. It is added on top of the colour correction 
you completed in the previous step.
To accomplish this look you can use a LUT. 
A LUT (Look Up Table) is a simple way to colour grade 
footage. 

1. Create an ‘Adjustment Layer’. Return to the ‘Editing’ 
workspace and select File > New > Adjustment Layer.



The following dialogue box will appear in the centre of the 
screen.

Click OK and the adjustment layer will appear in the “Project 
Panel’ at the bottom left of your workspace.

Select and drop the adjustment layer onto your ‘Timeline’ 
Drag it to the length of the clip you want to colour grade. To 
add this colour grade to your entire film drag the adjustment 
layer across all you colour corrected footage.

2. In the Lumetri panel, open the ‘Basic Correction’ tab. 

3. Select the ‘Adjustment Layer’ on your ‘Timeline’.

You will add your LUTs to this adjustment layer and make 
your corrections without affecting the original clip. (You can 
also change the opacity of the adjustment layer to add more 
or less colour change to the clip underneath.)
Now that you have created and placed your ‘Adjustment 
Layer’ return to the ‘Colour’ workspace.

4. Under ‘Basic Correction’, select the ‘Input LUT’ dropdown 
menu, and click on ‘Browse’. Premiere Pro has a number of 
pre-loaded LUTS. Select one of the LUTs in the menu and 
you will see the colour change. 
You might like to try a number of them until you find the 
“look” you want.



4. You can further adjust the LUT by using the same colour 
correction tools (the sliders) that you used to colour correct 
your clip.

STEP 7: Sound design

It has often been said about film making, that sound is half 
of the final product and should therefore be given a lot more-
attention than it sometimes fails receives. 
In this step we will look at three aspects of sound; voice, 
sound effects and music and how they interact with one 
another to enhance a story.
If you haven’t already done so import your sound effects 
and the audio you recorded via the lapel microphone. If they 
haven’t been exported to a format that Premiere Pro can 
recognise you will find out how to accomplish that by taking 
a look at the last few pages of the ‘Sound’ section where it is 
all explained.
Place all your sound effects into a separate folder labelled 
‘Sound Effects’. Save this in the GFX folder in the ‘Projects’ 
panel.
Place all your voice recordings in a separate folder labelled 
‘Audio Masters’. Save this in the ‘Masters’ folder in the 
‘Projects’ panel.

It is important in sound design to have an organised 
Timeline.  You will need four audio tracks; camera audio 
(Audio 1), microphone audio (Audio 2), sound effects (Audio 
3) and music (Audio 4). Make sure they are in this order, top 
to bottom.



Microphone Audio (Audio 2)
Transfer the audio files to the timeline. Match each one up 
as close as you can to the video clips you have shot. Do this 
clip by clip. It will take a while but it will be worth the sound 
quality improvement in the end.

Camera Audio (Audio 1)
As mentioned previously camera audio is not the greatest 
but it is important to have it as reference audio for what we 
are about to do. 

The audio clips will automatically line up!
Work you way through the rest of the clips.

Select the camera audio and microphone audio while 
holding down the ‘Shift’ key.

When both clips are selected navigate to: 
Clip  > Edit  > Synchronise.

You can leave the camera audio on the ‘Timeline’ just 
in case you accidently move the microphone audio. It 
happens! Then you will neeed to re-synchronise the camera 
and microphone audio.
If you go this way, mute the camera audio (Audio 1) so that 
you can only hear the microphone audio (Audio 2).



If the combined audio is too loud it will break the 0db and 
look something like this in the ‘Audio Meters’ monitor.

Sound Effects (Audio 3)
Add the sound effects files to your ‘Timeline’ and adjust 
them until they are where you want them. This is more an 
art than a science and you will probably play some parts of 
your film back again and again, until you are happy with the 
timing.

Music (Audio 4)
Hopefully you’ve already placed the music where you want it 
in ‘Step 4: Shape the story through music’. Now play it back 
with the camera audio and sound effects turned on. 

Sound levels
The combined sound of all your audio tracks should be no 
more than 0dB (decibels). In order to keep an eye on this we 
will need to monitor the ‘Audio Meters’ panel at the bottom 
right of the ‘Editing’ workspace.

You will see something like this when you are playing your 
film. Note that the bars; left and right (stereo) are green. 
This means that the audio levels are considered safe.

 
Notice the red at the top of the monitor. This is known as 
‘audio clipping’. 

What is audio clipping?
The audio is starts to ‘break up’ and sounds slightly 
distorted. The more severe the clipping, the more distorted 
the sound becomes. 

Adjust your sound levels
This process is an art and a science. You will particularly 
want to balance the play between the voices and the music 
but also listen out for how the sound effects interact. You 
may need to decrease the music so that the voice can be 
heard. A subtle sound effect may need to be increased in 
volume or a reduced in volume if it is too loud. This is the art 
of sound, but keep in mind the science of sound. The overall 
audio levels must be below 0dB. Keep an eye on that ‘Audio 
Meters panel.



STEP 8: Text

Now is the time to a add a film title and end credits.

Add a film title
There are a number of ways to do this but for this film title 
we will use the type tools found in the ‘Essential Graphics’ 
workspace. 
Go to Window > Workspaces > Graphics in the main menu,

or click ‘Graphics’ in the ‘Workspace’ panel at the top of your 
workspace.

Adjust an entire track
If you want to raise or layer the volume of an entire track 
navigate to the audio track you want to adjust on the 
timeline. You will notice that there is a white line running 
through the track. Click on this track, hold left-click down on 
the mouse and raise or lower the line until you are happy 
with the audio levels for that track.

Vary the adjustment within a track
Often you will want to do this with music.You may want to 
bring down the volume when a character in your film begins 
to speak but lift the volume when they are not. You may 
want to fade out a track at the end of a scene. For these 
adjustments we will turn to the ‘Pen Tool’ in the tools panel. 

We will build a simple audio ramp from silence to full 
volume. Click on the white line where you want to start the 
ramp and again where you want to bring the music to full 
volume. You will notice little dots appear on this line when 
clicked with the pen tool. Lower the left hand dot like this. 
You can adjust all your audio tracks in the same way.



Your workspace should look something like this:

The right hand panel is the ‘Essential Graphics’ Panel
Choose Edit > New Layer (‘Turning Page’ Icon)

Choose ‘Text’ from the drop down menu.

Make sure you playhead is over the clip where you want 
your title to appear and left-click inside the ‘Program’ 
monitor. You will now have a text layer overlaying your clip 
and a text box in your ‘Program’ monitor.

Your ‘Essential Graphics’ panel will now look like this:



To change your font double click the text in the text box and 
navigate to the ‘Text’ panel in the ‘Essential Graphics’ panel. 

You can choose a new font by clicking on the arrow next to 
the font panel and scrolling through the drop down menu 
until you find your desired font. 

Click inside your text box, drag the cursor across the 
existing text “New Text Layer”, and type your title.

To centre your text in the monitor click the first two icons 
under the ‘Align and Transform’ controls.

To change the colour of your text navigate to the 
‘Appearance’ panel and click ‘Fill’.

With your text in your text box selected, click on the colour 
you would like. The title will change to that colour



Adjust the text layer on the ‘Timeline until it is at the desired 
length.

You may like to fade your text in and out. You will learn how 
to do this in ‘STEP 9: Transitions’.
But before we do that let’s create a scrolling credits 
sequence for the end of your film.

Add a scrolling end credit sequence
Return to the ‘Essential Graphics’ panel and start as you did 
with your film title. 
Choose Edit > New Layer (‘Turning Page’ Icon)

Choose ‘Text’ from the drop down menu.

The text layer will appear in your ‘Timeline’ and the text box 
will appear in your ‘Program’ monitor as before.

Start to type the credits in the text box one after another. 
In this example the font, colour and size of the names has 
been changed.

To change the font and colour follow the instructions under 
‘Add a film title’. The names are in a reduced text size. In 
order to do that do the following:



Navigate to the ‘Text’ panel and grab the little circle 
highlighted below. Scroll left and right until the text is at the 
required size.

When you have typed and formatted your entire credit 
sequence deselect the text and return to the ‘Essential 
Graphics’ panel.
Click on ‘Roll’ and the credit sequence controls will appear.

(Make sure ‘Start Offscreen’ and ‘End Offscreen’ are ticked.)

You now have a scrolling end credit sequence.
In order to slow down or speed up the credit sequence 
return to the ‘Timeline’ and change the length of the title 
layer as described in ‘Add a film title’.
If you make the title layer longer the text will scroll more 
slowly. If you make the title layer shorter it will scroll more 
quickly. Once again you can apply add “fade in” and 
“fade out” transitions to the text layer as described on the 
following pages.



STEP 9: Transitions

Now that you have assembled your film you may like to add 
transitions; fade in, fade out or cross dissolve.

What is a fade in?
A fade in is a transition that fades from a blank screen to a 
picture. It is mostly used at the beginning of a film or scene.

What is a fade out?
A fade out is a transition that fades from a picture to a blank 
screen.  It is mostly used at the end of a film or scene.

What is a cross disolve?
A cross dissolve is a transition in which the opacity of one 
scene is gently increased over the previous one. It contrasts 
with the sharp transition of a jump cut. One scene fades into 
the next and the two images briefly overlap.

How to add a fade in/out
Open the ‘Effects’ workspace by selecting Window/
Workspaces/Effects at the top of the screen.

Your ‘Effects’ panel is at the top right hand corner of the 
workspace.

Type ‘Film Dissolve into the search bar.

Select the clip on your timeline that you will fade into or out 
from and drag the ‘Film Dissolve’ icon onto that clip.



It should look something like this if it is a “fade in”,

or this if it is a “fade out”.

To edit the length of your transitions, position the cursor on 
the edge of the ‘Film Dissolve and drag it one way or the 
other. Below is the “fade out”. (Note that the cursor changes 
appearance when you are in position.)

How to add a ‘Cross Dissolve’
Navigate to your ‘Effects’ panel and type ‘Cross Dissolve’ 
into the seach bar.

Drag the ‘Cross Dissolve’ icon onto the cut between the two 
clips that you want to transition.

Once again you can shorten or lengthen this transition. 
Position the cursor at the edge of the dissolve and drag it to 
your required length. (Both ends of the transition will move.)



Special effects

1. Green screen editing
Shooting with a green screen involves filming a person or 
object in front of a solid color. Then, by digitally removing 
or “keying out” that color, you can drop the image onto the 
background of your choice in post-production. Removing the 
colored background can be referred to as “chroma keying.

Below is a still of the scene we will be working on from 
‘Phone Home’. (1:54 - 2:00)

Here is a step by step guide to using this effect.

Step 1: Start a new project

Start a new Premiere Pro project for your ‘green screen’ 
scenes. The project should have the same dimensions as 
your master project. If it is HD it should be 1920 X 1080. If 
it is 4K it should be 3840 x 2160. You will eventually import 
the finished video into your master project.

https://www.youtube.com/watch?v=CX-
ghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGe-
y_&index=2

Step 2: Import your background footage or photo 

Place the background footage or photo into the Media Bin 
and drag it onto the timeline. Place it on the ‘Video 1’ track.

https://www.youtube.com/watch?v=CXghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=2
https://www.youtube.com/watch?v=CXghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=2
https://www.youtube.com/watch?v=CXghh-LIIt4&list=PL3PLBv5OrbIpuYhim35XKkIzwhbiBGey_&index=2


Step 3: Import your green screen footage 

Place it on the Video 2 track of the timeline. Position it 
directly above the background footage on the ‘Video 1’ track.

If you are using a photo that is not the same dimnesions as 
the green screen footage you will need to rescale it to fit the 
frame.
Go to ‘Effects Controls’ and change the size of the photo by 
scrolling the blue number next to ‘Scale’ left or right to fit the 
frame.
To move the photo up and down or left and right scroll the 
numbers next to ‘Position’ left or right. The number on the 
left moves the photo left and right. The number on the right 
moves the photo up and down. 

Step 4: Navigate to the ‘Effects’ panel 

Click on ‘Window’ and ‘Effects’ in the drop down menu at the 
top of the screen. 

You will find the ‘Effects’ panel in the top right hand corner 
of the screen. In the ‘Effects’ panel, type ‘Ultra Key’ into the 
search bar next to the magnifying glass. Drag the ‘Ultra Key’ 
block onto the green screen footage.  



Below you will still see some of the background coming 
through the footage.

This is what the unedited footage looks like.

Step 5: Drag the ‘Key Color’ picker tool onto the green 
screen footage 

This is the clip on the ‘Video 2’ track. If the green screen 
hasn’t been evenly lit, choose the darkest shade of green.

Click on the drop down menu next to the ‘Output’ title. From 
the dropdown menu choose the ‘Alpha Channel’.

Your clip will now look something like this. (It will be easier 
for you to see changes in this form as you adjust the green 
screen effect. You will of course swap it back to composite 
when you have finished editing.)



Step 6: Fine tune the green screen effect

Now it is time to edit the clip using the tools below. Generally 
you will need different settings for each clip.

To adjust each setting place the cursor on the numbers in 
blue next to the titles and scroll the cursor left or right. 
Start from the top tool ‘Transparency’ and work your way 
down until you are satisfied that you have removed the 
green screen. 
When ‘Output/Apha Channel’ has been selected, work your 
way through each setting until you see the green screen turn 
black with, hopefully, no gray or white spots and the figure or 
object turn white with no gray or black spots. 
Highlight, Contrast and Mid-Point were used for this clip.

Here is what the image looks like at the end of this process.

And when you click from ‘Alpha Channel’ back to 
‘Composite’ it looks like this.

Obviously there is still a lot of the old background visible 
because the green screen did not cover the entire frame. 
During the next step we will look at how to remove the rest 
of the background.



Step 7: Crop the background

Navigate back to the ‘Effects’ panel via the ‘Effects’ 
workspace. Type ‘Crop’ into the search bar next to the 
magnifying glass. Drag the ‘Crop’ block onto the green 
screen footage.

The ‘Crop’ controls will appear in the ‘Effects Controls’ panel 
on the left hand side of your screen.
Scroll the cursor over the ‘Left’, ‘Top’, ‘Right’ and ‘Bottom’ 
controls one by one until you have cropped out all the 
unwanted background.

The image now looks like this.

Step 8: Render your project

When you hit this tab the entire sequence will be rendered 
and ready for export.

(When this sequence was created for Phone Home the po-
sition of the figure wasn’t right. It needed to move down and 
to the right before this clip was ready for export. In the next  
section, ‘Motion’ you will learn how to move actors and ob-
jects within the frame.)



2. Motion

The ‘Motion’ tool enables an actor or object to be moved 
to another position within the frame. It can also be used for 
simple animation. The controls for ‘Motion’ are found at the 
top of the ‘Effects Panel’.

Click on ‘Position’. Don’t click on the circle.

When you scroll the curser on the blue number on the left 
you can move the image left and right (horizontally).
When you scroll the curser on the blue number on the right 
you can move the image up and down (vertically).

Original position.

New position.

Now we will look at animating an object within the frame. In 
this case a chair flying through the lounge room from the left 
to the right.
Another shot of the loungeroom will be imported into the 
same sequence as it part of the scene. Place it on ‘Video 1’.



We are using a wider image of the same loungeroom than 
the last clip. It is a large image and when it is dragged onto 
the timeline from the ‘Media Bin’ it is too close up for what is 
needed. Click on the clip.

Return to the ‘Effects Panel’ and scroll the cursor across the 
blue numbers and adjust ‘Position’ and ‘Scale’ until you have 
positioned photo.

The photo will now look like this.

Now we will import a chair photo to the ‘Media Bin’. It has 
a transparent backgound so will be ready to place over the 
background photo.

Drag the photo to the timeline and place it ‘Video 2’ above 
the background on ‘Video 1’.

Obviously the photo is far too large and will need to be 
rescaled by using the ‘Scale’ tool in the ‘Effects Panel’. 
Make sure you click on the clip before you do it.



It will now look something like this.

We will now animate the chair flying across the room.
You will need to click the circle next to ‘Position’ in ‘Effects 
Control’. 

Take the playhead to the opening frame of your chair clip. 
Make sure you have selected the clip.

Drag the chair just out of frame to the right by scrolling the 
cursor across the blue number on the left next to ‘Position’.

Take the playhead to the end of your chair clip. It will be one 
frame before the end. 
(Make sure the clip is still selected.)

Now drag the chair just out of frame to the left by scrolling 
your cursor across the blue numbers that control horizontal 
movement next to the ‘Position’ tool.

When you play the clip you will see the chair fly across the 
room in a straight line. 

Next we will add a little curve to the flight of the chair so that 
is at it’s highest point in the middle of the clip. Run through 
your clip until the chair is about in the middle of the frame.
Now scroll your cursor across the  the numbers that control 
vertical movement next to the ‘Position’ tool.



When you play the clip you will see the chair fly across the 
room in a curved trajectory.

The clip is far too slow so we will now speed up the clip by 
using another tool at our disposal. After you export the clip 
and place it on the ‘Master’project you can do the following.
Select the chair clip.
Click on clip and speed duration at the top of your Premiere 
Pro screen like this.

When you do this the following will appear in the centre of 
your screen.

By scrolling across the blue numbers next to ‘Duration’ 
using your cursor you can change the length of the clip and 
the speed. Tweak it until you have the desired length and 
speed.

So this scene involved two special effects clips. The first 
was largely green screen using the ‘Ultra Key’ tool while the 
second created animation using the “Position’ tool.
We used the same ‘Speed Duration’ tool to slow down the 
clip where James starts to throw the chair. Interestingly the 
audio of the slowed down clip sounded great so we left it in 
the edit.

Step 10: Export your saved project
There is a comprehensive step by step guide for exporting 
footage in section eight of this course.





export

Step 1: Open the export window

To export a video in Premiere Pro, go to File>Export>Media 
while your project is open. You could also press the shortcut 
key Ctrl + M on PC, or Cmd + M on Mac. 



This will bring up your Export Settings window. In this 
window, you’ll select your desired settings (or presets) for 
the video, before sending it to Media Encoder for exporting. 
This is what is looks like on the screen.

Here is what the export screen looks like close up. On the 
following pages we will look at the settings in more detail.



You can bypass the custom settings outlined in the following 
pages by export with the exct settings of your sequence, 
Tick the box next to Match Sequence Settings at the top. 
That’ll change your export settings to exactly match your 
sequence settings. You may do this because you are not 
sure what you will do with your finished product and just 
want a copy for yourself or to show others.

Step 2: Work out where your video will be viewed

The first thing to think about when exporting a video is 
where the video will be delivered and how it’ll be viewed. 
Are you exporting a compressed video so you can quickly 
send it to a client? Will you be exporting from Premiere Pro 
to YouTube or Vimeo? Are you exporting a hi-resolution 
master version for a big screen presentation? The delivery 
destination determines what the settings need to be.

Step 3: Choose Your Sequence Settings

There are loads of useful presets already installed with Pre-
miere Pro and Media Encoder. You can use these presets to 
quickly choose settings for your exported file.

However, for this example, we’re going to be export using 
custom settings.



Step 4: Select a format

What is a format?
A format or codec is software that compresses your video 
so that it can be stored and played back. The most common 
format is H.264, which is often used for high-definition digital 
video and distribution of other video content.

The best setting for web playback is also the H.264 format. 
So, we’ll select our format as H.264. That is also the most 
common format for video exports through Premiere. For 
eighty to ninety percent of your exports, you’ll be using 
H.264.

Step 5: Select a preset and adjust your bitrate

What is bitrate?
In video streaming, bitrate refers to the number of bits that 
are conveyed or processed in a given unit of time. In video, 
a higher bitrate accommodates higher image quality in 
video output.

We’ll select a preset that matches our sequence and desired 
output. Our sequence is 1080p (1920pixels x 1080 pixels)
with a frame rate of 25 fps (frames per second).
We will use a high bitrate that will require internet speeds 
of 15Mbps to play back at full HD. If you know that your 

video may be viewed on the internet with slower speeds you 
would lower your bitrate. This would also lower the 
video quality but allow to be played clearly at lower internet 
speeds.

Step 6: Name your video file

Click the output name to specify an output name for the 
exported video file. 

Step 6: Choose where you will save the file

Click on the name you have chosen to bring up the following 
dialogue box. Set your file destination.



Step 8: Click the Export Video and Export Audio boxes
 
The file will be exported with video and audio.

Step 9: Check your summary

Work through this list to make sure your video will be 
exported as you want it before you export it. 
In this case the input and output and the source are 
matched.

Step 10: Click the Render at Maximum Depth box 

This will increase your render time but maximum depth 
increases the color depth of your video.

Step 11: Adjust your bitrate settings

The bit rate decides how big your file size will be. If you 
need a small file size, you can trim down your bitrate to 
minimize size. For a master copy you should export with a 
high bitrate to ensure the highest quality video.
Change the Bitrate Encoding Settings to VBR, 2 Pass, then 
drag your Target Bitrate to your selected file size. The size 
will be shown at the bottom of the window.



Step 12: Export in Premiere pro

Selecting Export simply exports the sequence from your 
project window. You won’t be able to use Premiere Pro while 
it’s exporting this way.
You have now exported your finished video!





distribution

Once you’ve got the final master of your film, it’s time to 
show the world. It’s rare that independent filmmakers have a 
sufficient budget for marketing or even have such a budget. 
There is a streaming service that has more subscribers 
than Netflix, Disney Plus or Prime Video, and that service is 
YouTube.
YouTube has more than two billion users and it is absolutely 
free to start a YouTube channel.
In this section we will take you through the steps you need 
to take to start a personal YouTube channel to showcase 
your films.
There are a number of steps that will be explained in the 
following pages. 



STEP 1: Create a Google account

To create a Google account click on the link below:

https://accounts.google.com/signup/v2/webcreateac-
count?hl=en&flowName=GlifWebSignIn&flowEntry=SignUp

Fill out you details and click next.

Fill out you details and click next.

You can opt in to their extra services or click skip.

https://accounts.google.com/signup/v2/webcreateaccount?hl=en&flowName=GlifWebSignIn&flowEntry=SignUp
https://accounts.google.com/signup/v2/webcreateaccount?hl=en&flowName=GlifWebSignIn&flowEntry=SignUp


Read through Google’s ‘Privacy and Terms’. 
Scroll to the bottom of the document and click ‘I agree’.

When you click ‘I agree’ you are taken to the following page. 
You now have a Google account.

Step 2: Create a YouTube account

On the google account page click tab next to the red letter in 
the top right hand corner of the screen.
You will see this.

Click on the YouTube tab. It will take you to your Tube 
account.



Step 3: Go to your YouTube channel

On the YouTube account page click tab next to the red letter 
in the top right hand corner of the screen.
You will see this.

Click on ‘Your Channel’.

Click on upload video.

‘Drag and drop video’ files from the desktop or select files by 
clicking ‘Select Files’.



You will be taken to an information page that you must fill 
out before your video can be uploaded to YouTube. While 
you do this your Video will be processed as a ‘SD’ (Standard 
Definition video) and ‘HD’ (High  Definition video).

What is HD and SD video?
HD (or High Definition) refers to higher quality video than SD 
(or Standard Definition). On HD, the picture will be sharper 
than on SD. On YouTube, HD means a video has 720–1080 
lines of vertical resolution (shown as 720p or 1080p in the 
quality settings of the YouTube player). Compare this to 360 
or 480, which are typical for SD.

Fill in the information on the following page.
Add a description.

You can add a ‘Thumbnail’ or rely on the image that 
YouTube chooses from your video.
If you want to upload your own image click the ‘Thumbnail’ 
icon and follow the prompts.



You can organise your videos into ‘Playlists’. 
‘Playlists’ are important for a number of reasons but for now 
it is enough to say that they make it easy to arrange your 
content into different categories.
When someone new visits your channel page, they can 
easily find the content they are looking for.

Now determine the audience for your video. Read the 
information in this section. It is very important to understand 
how your audience choice affects what will happen on your 
channel. The information is clear.

Click through the ‘Video Elements’ screen to ‘Checks’.
This page looks for any copyright issues in your video 
including unlicensed music. YouTube will not allow you to 
upload video that has copyright infringements. 



When you click ‘Next’ you will arrive at the following page.
Your choices here will determine where, when and by whom 
you video will be seen.
In this case we will check ‘Public’ so that everyone can see 
the video.
Click ‘Publish’.

This page enables you to send the video link to people on 
all the platforms indicated.

It is also available on your ‘YouTube Channel’.


